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Welcome

Welcome
Thank you for choosing GAGEpack to meet your gage management needs! The purpose of this document is
to explain in detail the many forms and features that can be found throughout the software. If you need
more information or if you have any questions about GAGEpack, please feel free to contact us.

In this chapter

What's new in GAGEpack 13

About your GAGEpack documentation

About PQ Systems

How to contact PQ Systems

Technical support

Maintenance support agreement

PQ Systems end-user license agreement

Request for new features

Training and consulting services

What's new in GAGEpack 13

What's new in GAGEpack 13

To see the complete list of development notes documenting changes made to GAGEpack, go to Help >
Documents > Whatʼs new.

See Also
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Technical support

Maintenance support agreement

PQ Systems end-user license
agreement

Request for new features

Training and consulting services

About your GAGEpack documentation
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About your GAGEpack documentation

GAGEpack documentation includes the following. Unless otherwise noted, these resources can be found in
the Documents folder in the GAGEpack installation directory.

§ GpUserGuide120.pdf - This is a PDF version of the GAGEpack user guide. It is located in the
GAGEpack installation directory.

§ Built-in Help - While using GAGEpack, you can press F1 at any time to view the Help documentation
for the screen youʼre currently using.

§ Getting started with GAGEpack-SQL.docx – Step-by-step instructions for creating and connecting
to the SQL Server database used by GAGEpack-SQL.

§ Getting started with GAGEmail.docx – Step-by-step instructions for installing and configuring
GAGEmail.

§ Getting started with GAGEmobile.docx – Step-by-step instructions for installing and configuring
GAGEmobile.

§ GAGEpack Reporting Scheme130.doc – Explains the syntax used by GAGEpackʼs internal reporting
engine. This document will be useful to anyone trying to learn how to modify or create GAGEpack
reports or labels.

§ Management Statistics in GAGEpack 13.0.doc – Explains the syntax used by the chart-rendering
engine in GAGEpackʼs management statistics.

§ Importing external calibrations into GAGEpack.doc – Explains how to use the Import external
calibrations utility located under Utilities > Import > External calibrations.

See Also
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About PQ Systems

About PQ Systems

For nearly 30 years, PQ Systems, Inc. has been dedicated to helping organizations demonstrate proof of
their quality performance. We are a full service quality management firm offering a comprehensive network
of products and services designed to help all industries improve quality and comply with standards. PQ
Systems provides the expertise, training, and software tools necessary to assist organizations through every
step of the quality process. Our highly-regarded products have made us a leader in the industry, but our
commitment to customer service and support keeps customers coming back.

Software

SQCpack® combines powerful statistical process control techniques such as variables, attributes, and Pareto
charting with flexibility and ease of use.
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GAGEpack® builds a complete database of an unlimited number of measurement devices, instruments, and
gages from which users can generate a variety of reports. It supports ISO 9000, QS-9000, ISO/TS 16949-
2009, ISO/IEC 17025, and other standards.

Training and consulting

PQ Systems' consultants and trainers have extensive knowledge and experience in the areas of SPC,
continuous improvement, ISO 9001, and trainer and leadership development in a wide variety of industries
and organizations. In addition to customized in-house training, we offer public seminars.
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How to contact PQ Systems

How to contact PQ Systems

PQ Systems invites your questions and comments about our products and services.

Sales phone: 800-777-3020 or 937-885-2255

Sales email: sales@pqsystems.com

PQ Systems, Inc.

210 B East Spring Valley Road

Dayton, OH 45458

Call sales for:

o General information to help you decide to purchase or evaluate the
software

o Place an order or to check the status of an order.

You can send a fax to either Sales or Technical support at 937-885-2252. To ensure that your fax is
delivered quickly to the right department, please send it to Attn: Sales or Attn: Technical support.

World Wide Web URL

http://www.pqsystems.com

http://www.sales@pqsystems.com
http://www.pqsystems.com
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Technical support

Technical support

Phone: 800-777-5060 or 937-885-2255

Email:support@pqsystems.com

Call PQ Systemsʼ experienced technical support team. Our experts can answer questions about software
problems, data analysis, and applications.

Before you call, please follow these steps to help our technical advisors answer your questions quickly:

1. Have your license/serial number ready. It is listed in the About dialog box. You can access this dialog
box by selecting Help > About from the menu.

2. Be at your computer, if possible.

3. Review the topic for which you have a question in the User's Guide and On-line Help.
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The product comes with an initial year of maintenance. After that, you must renew your product
maintenance in order to ensure your continued access to the following great benefits:

1. Free software updates via download or DVD- The product continues to evolve with suggestions
from customers like you. Renewing your maintenance plan gives you access to 12 months of updates
that include new features, improved usability, and compliance with the latest regulations from ISO
9001, JCAHO, FDA, and other regulatory bodies.
http://www.pqsystems.com/support/SoftwareUpdates.php

2. Access to our legendary technical support - Our support team has kept customers coming back for
more than 30 years. Renewing your maintenance plan will provide access to our professional support
staff. You have access to software and statistical application help via the phone, and in North America
the number is toll-free.

3. Unlimited access to online training – Any and all of your gage technicians can view our online
training webinars, either by attending the session live or by accessing previously recorded webinars
from within the software.

4. Free subscription to Quality eLine - Quality eLine is our highly-acclaimed monthly electronic
newsletter offering tips and techniques to enhance your software use and make your day-to-day work
easier. Quality eLine includes Professor Clearyʼs renowned and always entertaining Quality Quiz.
Renewing product maintenance will ensure that you do not miss a monthly issue.
http://www.pqsystems.com/eline/

5. Peace of mind - If your team depends on the product for its improvement charting, having a
guaranteed direct line of contact to a committed support team offers priceless peace of mind,
especially during an audit or survey. Renewing your maintenance support agreement ensures that the
privileges of product maintenance continue uninterrupted.

Contact PQ Systems to renew your maintenance support agreement.

For additional details, go to:

http://www.pqsystems.com/support/MaintenanceSupportLicense.php

Additional
Information

How to contact PQ
Systems

See Also
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PQ Systems End-User License Agreement for the Per-Computer or
Concurrent-User License Model
This End-User License Agreement ("EULA") is a legal agreement between you (either an
individual or a single entity) and PQ Systems, Inc. for the PQ Systems software that
accompanies this EULA, which includes computer software and may include associated media,

http://www.pqsystems.com/support/SoftwareUpdates.php
http://www.pqsystems.com/eline/
http://www.pqsystems.com/support/MaintenanceSupportLicense.php
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printed materials, "online" or electronic documentation, and Internet-based services ("Software").
An amendment or addendum to this EULA may accompany the software. YOU AGREE TO BE
BOUND BY THE TERMS OF THIS EULA BY INSTALLING, COPYING, OR OTHERWISE USING
THE SOFTWARE. IF YOU DO NOT AGREE, DO NOT INSTALL, COPY, OR USE THE
SOFTWARE; YOU MAY RETURN IT TO YOUR PLACE OF PURCHASE FOR A FULL REFUND,
IF APPLICABLE.

License
The Software may be licensed under the Per-Computer or the Concurrent-User license model.

Per-computer License Model - Under the per-computer license model, PQ Systems grants to
you a nonexclusive right to install and use the Software on a single computer that is owned or
controlled by you. You must purchase a registered per-computer license for each computer on
which the Software is installed. If you use the Software through a network, you must still obtain
individual licenses for the Software to cover each individual computer that will execute the
Software through the network. For instance, if ten different computers will use the Software,
each computer must have its own registered license, regardless of whether the Software is
used at different times or concurrently.

Special provisions for using the per-computer license model in a terminal server environment
- Windows Terminal Server, Windows Terminal Services, and various Citrix products are
technologies that allow users from a variety of remote client devices to concurrently execute the
Software that has been installed on a Windows server. All of these technologies are referred to
as a terminal server environment under which the following licensing restrictions apply. A per-
computer license must be purchased for each 'device' that 'runs' the Software. 'Device'
encompasses client hardware devices, computers, workstations, terminals, or other digital
electronic or analog devices that enable an end user to run the Software. To 'run,' or 'running,'
the Software means using, accessing, displaying, running, or installing the Software, regardless
of the medium of access to the product.

Concurrent-User License Model - The Concurrent-User License is offered under a subscription
license term. Under the concurrent-user license model, PQ Systems grants to you a
nonexclusive right to install the Software on multiple networked computers that are owned or
controlled by you, and to concurrently use the Software, such that at any time, the total number
of concurrent users of the Software is equal to or less than the number of concurrent users
purchased by you. You agree to run a single instance of the PQ Systems' License Manager
software within your network in order to limit usage of the Software such that no more than the
purchased number of users can concurrently run the Software. You may install the PQ Systems'
License Manager software on a backup computer to use only in the event that the primary
computer fails. Any attempt to concurrently run more than one instance of the PQ Systems'
License Manager, or by any other means to concurrently run more than the purchased number
of users, is in violation of this license and may result in termination of this license agreement.

License term
The term of this license may be perpetual or may be purchased in fixed units of time on a
subscription basis.

Perpetual Term - A perpetual license term does not expire.

Subscription Term - A subscription license term expires at the end of the time period purchased
by you. The Software will not function after the end of the purchased time period.

Evaluation period
Subject to the terms of this agreement, you are permitted to use the Software for evaluation
purposes without charge during the evaluation period. If you want to use the Software after the
evaluation period, then a license must be purchased. The evaluation period may vary from one
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PQ Systems product to another, but in no case does the evaluation period extend beyond 90
days from the first use of the Software.

Unregistered use of the Software after the evaluation period is in violation of U.S. and
international copyright laws.

Product specific provisions
CHARTrunner – This EULA does not apply when CHARTrunner software components are used
by the server side of a client-server application. In that case, a different type
of CHARTrunner license must be purchased. Contact PQ Systems for further information.

Further explanation of copyright-law provisions
You may not otherwise modify, alter, adapt, merge, decompile, or reverse-engineer the Software
and you may not remove or obscure PQ Systems' copyright or trademark notices.

Per-computer License Model - You may transfer all of your rights to use the Software to another
computer, provided that you transfer to that computer all of the Software, together with all copies,
tangible or intangible, including copies in RAM or installed on a disk, as well as backup copies.
Remember, once you transfer the Software, it may be used only on the single computer to which
it is transferred. Except as stated in this paragraph, you may not otherwise transfer, rent, lease,
sublicense, timeshare, or lend the Software. Your use of the Software is limited to acts that are
essential steps in the use of the Software on your computer as described in the documentation.

Concurrent-User License Model - You may not transfer, rent, lease, sublicense, timeshare, or
lend the Software. Your use of the Software is limited to acts that are essential steps in the use
of the Software on your computer as described in the documentation. You may not use any
means that permits more than the purchased number of users to concurrently use the Software.

Subscription Term - You may not use any means that permits the Software to run after the end
of the purchased time period.

Electronic communications
The Software may from time to time transmit data to and from PQ Systems servers via the
internet. This information transfer may be used to notify you when newer versions of the
Software are available, for verifying license compliance, or for other purposes. PQ Systems will
not collect any personally identifiable information from your computer during this process.

Governing law and general provisions
This license statement shall be construed, interpreted, and governed by the laws of the State of
Ohio, USA. If any provision of this statement is found void or unenforceable, it will not affect the
validity of the balance of this statement, which shall remain valid and enforceable according to its
terms. If any remedy provided is determined to have failed of its essential purpose, all limitations
of liability and exclusions of damages set forth in the Limited Warranty shall remain in full force
and effect. This statement may be modified only in writing signed by you and an authorized
representative of PQ Systems, Inc. Use, duplication, or disclosure by the US Government of
computer software and documentation in this package shall be subject to the restricted rights
applicable to commercial computer software (under DFARS 52.227-7013). All rights not
specifically granted in this statement are reserved by PQ Systems, Inc.

Disclaimer of warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD “AS IS” AND WITHOUT
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER
WARRANTIES WHETHER EXPRESSED OR IMPLIED. Because of the various hardware and
software environments into which the Software may be put, NO WARRANTY OF FITNESS FOR
A PARTICULAR PURPOSE IS OFFERED.
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Good data processing procedure dictates that any program be thoroughly tested with non-critical
data before relying on it. The user must assume the entire risk of using the Software. ANY
LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT
OR REFUND OF PURCHASE PRICE.

PQ SYSTEMS, INC.
Corporate Headquarters: 210 B East Spring Valley Road, Dayton, Ohio 45458, USA, (937) 813-
4700, http://www.pqsystems.com. International Offices: Australia +61 3 9999 7347, United
Kingdom 0044 (0) 1704 871465.

All PQ Systems products are trademarks of Productivity-Quality Systems, Inc., Copyright ©
1998-2016 Productivity-Quality Systems, Inc.

All rights reserved.

For the most recent agreement, go to:

http://www.pqsystems.com/support/LicenseWorkstation.php
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Request for new features

PQ Systems wants to provide you with software that meets your quality needs. To do this, we need your
input. If there is a feature, function, or operation that you would like to see in a future version of the
software, please go to Help > Feedback or click here.
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PQ Systems end-user license agreement

Training and consulting services

Training and consulting services

Training and consulting services

Training and consulting services are offered by PQ Systems for companies at all stages of their quality
management programs. A staff of highly-qualified consultants brings practical experience from both
industrial and academic environments. Seminars and on-site training programs are available to help
companies implement successful quality management programs.

For more information, visit: http://www.pqsystems.com/training/
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Getting started
This chapter will discuss the initial setup of GAGEpack, including hardware and software requirements for
installation, creating a new database, upgrading an existing database, and launching the software. In
addition, we will examine the main menus and four main tabs to familiarize you with navigating within the
program.

In this chapter

Hardware and software requirements

GAGEpack database overview

Creating a new database

Upgrading an existing database

Starting GAGEpack

Menus

Tabs

http://www.pqsystems.com/training/
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Hardware and software requirements

Hardware and software requirements

In order to install GAGEpack, you must use a computer that is running an actively supported version of the
Windows OS. For GAGEpack 13, this includes:

§ Windows Vista
§ Windows 7
§ Windows 8.1
§ Windows 10
§ Windows Server 2008
§ Windows Server 2012
§ Windows Server 2016

See Also
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GAGEpack database overview

GAGEpack database overview

GAGEpack stores all gage information in a single database. In the standard version of the software, this is a
Microsoft Access format database file with a .gpg extension. GAGEpack-SQL, on the other hand, uses a SQL
Server database. In the following sections, we will be using the standard version of the software. For
information about creating and using a SQL Server GAGEpack database, please see the document Getting
Started with GAGEpack-SQL.
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Creating a new database

Creating a new database

To create a new GAGEpack database, go to File > New. You will be prompted to browse to the location
where the database should be saved, and to provide a name for the database.

Database files can be saved on any storage drive that your computer has access to. It is recommended that,
if possible, the database be saved on a shared network storage drive. In most organizations, these drives
are typically backed up on a regular basis. In addition, storing the database on a shared network drive will
allow multiple users to interact with the database at the same time from different computers.

The database can be given any name that is a valid Windows system filename. Once you have provided the
name, click Save. GAGEpack will create the new database and immediately open it for your use.

See Also

Getting started

Hardware and software requirements

GAGEpack database overview

Upgrading an existing database

Starting GAGEpack

Menus

Tabs

Upgrading an existing database

Upgrading an existing database

If you are upgrading to GAGEpack 13 from any version prior to v8.5, you must convert your database to v8.5
before continuing to v13. Please contact PQ Systems technical support if you need assistance with this.

1. To convert a v8.5 or later database to v13, go to File > Open.
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2. Browse to and select the database you would like to convert.

3. Click Yes to convert the database now.
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4. Specify the target directory for the new database (if necessary).

5. Click Start.
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See Also

Getting started

Hardware and software requirements

GAGEpack database overview

Creating a new database

Starting GAGEpack

Menus

Tabs

Starting GAGEpack

Starting GAGEpack

GAGEpack can be opened once it has been installed by double-clicking on the GAGEpack icon on the desktop,
or by navigating to the GAGEpack folder from the Windows Start menu.

If the database GAGEpack is opening has security enabled, the first window to be displayed will be the login
screen.
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Enter your login credentials (if required) and click OK to continue.

Note: Please see Configuring GAGEpack for more details about user rights and database security.

See Also

Getting started

Hardware and software requirements

GAGEpack database overview

Creating a new database

Upgrading an existing database

Menus

Tabs

File menu

File menu
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Open – Browse to and open a GAGEpack database. This action will close the current database, if there is
one open already.

New– Create a new blank GAGEpack database.

Switch user – Log out and log in as a different user.  This option is only available if database security is
enabled.

Settings - Open the preferences window to configure GAGEpack options.

Printers – Specify which printer GAGEpack should use by default when printing documents or labels.

Exit – Close the program.

About - View system information, such as version and license numbers

The file menu also displays recently opened GAGEpack databases to allow quick navigation between several
files.

Ribbon bar

Ribbon bar
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The ribbon bar at the top of the GAGEpack window contain functions that are available and useful from
anywhere in the software.  The tabs and buttons that are visible at any give time will change based on the
current context.

Home

Home

Gages - The buttons in this section are used to interact with gage records.  From here, gages can be
added, viewed, edited, copied, found, or deleted.

Reports - These reporting tools are used to retrieve information from the database and display it in the
given format.

Views - Used for creating and managing remembered states of the main form.

Grid - These controls are used to configure which rows and columns are available on the table showing on
the current tab.

To do list - Tools used to share the content of the to-do list.  This section is only visible on the Tasks tab.

History - Used to delete the selected gage event.  This section is only visible on the History tab.

Dashboard - Used to print the dashboard.  This section is only visible on the Dashboard tab.

Events

Events

The Events tab can be used to launch gage events.  It is not visible on the Archive, Audit, or Dashboard tabs.

Calibration - Used to launch internal or external, single-gage or multi-gage calibrations.

Inventory - These are gage management events, such as check-ins, check-outs, maintenance, and repair
events.

MSA - Measurement Systems Analysis.  These studies can be used to determine the capability of your
metrology practices.
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Utilities

Utilities

The Utilities tab contains important but rarely used gage and database management tools.

Settings - Launches the Preferences window, which is used to configure GAGEpack's options.

Search and Replace - A set of utilities used for making a single change to many gages at once.  Please
see the associated section in the Gage management chapter for details.

Replace master gage - A utility which will search through the gage inventory and replace every reference
to one master gage with a reference to a different master gage.

Master gage circular references - This utility will examine the master gages referenced on every master
gage in the database to check for circular references, no matter how large the circle is.

Barcoding - From here, barcode labels can be created with the 1D or 2D wizard, printed, and scanned.

Refresh due dates - Forces GAGEpack to recalculate due dates for all active gages in the database.  These
calculations are normally done automatically, so this utility should rarely be needed.

Load choice lists - This utility automatically builds the system choice lists using the contents of existing
gages.

WTA - Wear Trend Analysis - Utilities that examine the historical calibration results data for a gage to
estimate when it will need to be replaced.

Import - A collection of utilities designed to bring raw data into the database from external sources.  

Export - A collection of utilties designed to dump raw data to a universal format.

Backup - Used to manually create a backup copy of the current database.

Restore - Used to convert a previously created database backup into a full database.

Delete history - This utility will erase all historical gage events that took place prior to a user-entered date.

Query - A utility for creating and managing custom SQL queries.  Advanced users only.

Info - Displays the name and location of the current database file, along with a few statistics about the
database.

Help

Help
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The Help tab contains resources useful for learning how to use GAGEpack.  They include training videos, the
user guide, access to the PQ Systems support team, and technical documentation.

Tour - Launches a short introductory video for those just getting started with GAGEpack.

Training - Opens a web page with access to previously recorded webinar training videos.

Guide – A link to the user guide you are now reading

Legend - Shows the meaning of the color-coding being used on the current grid

Documents > Report scheme – This document explains the technical details of the reporting engine in
GAGEpack

Documents > Whatʼs new – A complete list of all development notes from the recent upgrades and updates

Documents > Error log – Opens GAGEpackʼs error log in a text editor

Support – Displays contact information for the PQ Systems technical support department

Chat – Launches an instant messaging chat interface with a PQ Systems representative.

Feedback – Allows the user to send a message directly to the GAGEpack development team with ideas for
improving the software.

Updates – Opens a web page that will tell the user if there is a newer version of GAGEpack available for
installation.

About - Displays the release number, license number, expiration date, and license details for this installation
of GAGEpack.
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Tabs

Tabs

The main user interface in GAGEpack is divided into seven tabs.  They are labeled and can be selected from
the left side of the screen. This section will discuss the purpose and primary features of each of these four
tabs.
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In This Section

Tasks tab

Inventory tab

History tab

Catalog tab

See Also

Getting started

Hardware and software requirements

GAGEpack database overview

Creating a new database

Upgrading an existing database

Starting GAGEpack

Menus

Gages

Gages

The Gages tab displays a list of every instrument that GAGEpack is currently tracking.  Every row represents
a single gage and can be double-clicked to view the gage card.  By default, the grid shows only Active gages,
but the Show archived gages box can be checked to include Archived gages as well.

Tasks

Tasks
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The Tasks tab displays the list of upcoming gage servicing events.  Double-clicking on any row in the grid
will launch the associated event for completion.  The chart at the bottom is used to visualize the distribution
of the upcoming workload across the selected date range.  The Tasks filter panel on the right allows the
user to specifiy the date range and which types of events should be included on the list.

History

History

The history tab contains a complete record of every gage event stored in the database. These records are
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color-coded by event type. Any event can be examined in more detail by double-clicking on the associated
row. The dropdown controls in the filter panel on the right can be used to filter the list to show a specific
event type and/or time frame.

Catalog

Catalog

The Catalog tab is similar to the inventory tab, in that it displays a complete list of your gages. The primary
difference between the two is that the catalog tab also displays a digital image of the gage.  The Catalog is
hidden by default. To show/hide it, go to Settings > Local settings > General

Archive

Archive
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The Archive tab is a listing of all of the retired gages in the system.  All information about archived gages,
including historical events, calibration and study data, and audit records is preserved; this tab exists simply
to move inactive records from the main Gages tab workspace and reduce clutter.

Audit

Audit

If auditing is enabled, the Audit tab will display a record of every trackable event in the specified time
frame.  Trackable events include users logging in and out, gages or gage events being added, edited, or
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deleted, and more.  The panel on the right side can be used to specify particular users or a date frame. 
This tab is only visible to users who have sufficient rights to review the audit trail.

Dashboard

Dashboard

The Dashboard offers summary information about the gage inventory, historical calibration events, and
upcoming gage events.  Clicking on any button or bar on the dashboard will display a list of the relevant
gages or events.

Grid controls

Grid controls

All tabs other than the Dashboard share a set of controls useful for interacting with the tab grids.  These
controls can be found on the Home tab of the ribbon bar and in the global filter panel on the right side of the
main screen.
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Filters - Can be used hide any gages that do no match a given criteria.  Please see the Gage
management chapter for details on how to use filters.

Print - Print the currently-visible grid, including all rows and columns being displayed.

Columns - Used to specify which columns should be visible on the grid.  This option is not available on the
History and Audit tabs.

Font - Sets the font size for all grids

Quick search - Typing in this box will hide all rows in the current grid that do not contain text that matches
what was typed.

GAGEpack files and folders

GAGEpack files and folders
This chapter will examine the purpose and contents of the folders that are created in the GAGEpack directory
during installation. It also discusses various files that GAGEpack interacts with during regular usage.

In this chapter

GAGEpack databases

Databases backups

Restoring gage databases from backup

Folders

GAGEpack databases
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GAGEpack databases

All gage information, including peripheral content such as gage history, users, vendors, choice lists, parts,
devices, etc, is stored in a single database file. The standard version of GAGEpack uses a Microsoft Access
database with a .gpg extension, while GAGEpack Enterprise uses a SQL Server database.

The folder-path and filename of the currently open database is always displayed at the top of the GAGEpack
window for easy reference.

To navigate quickly to the folder where the database is stored, go to Utilities > Info, and click the View icon.

Note: GAGEpack Enterprise will display and link to the database connection file (.dbc) rather than the
database itself. Please see the document ‘Getting Started with GAGEpack Enterpriseʼ for more details.

See Also

GAGEpack files and folders

Databases backups

Restoring gage databases from backup

Folders

Databases backups



GAGEpack

35 / 298

Databases backups

In This Section

Backing up gage databases on exit

Backing up an open gage database

Setting the backup directory

Setting the number of backups to be made

See Also

GAGEpack files and folders

GAGEpack databases

Restoring gage databases from backup

Folders

Backing up gage databases on exit

Backing up gage databases on exit

GAGEpack can be set to create a backup of a database file when the program is closed. If there are multiple
users and the database is in use (open) on another computer, a backup will not be made. When the last
user exits with the database open, a backup of the database will be made with the same name as the
database, except that the extension will be: .GB1. The default directory for the backup file is the directory
labeled Backup, which is created during the install. It resides under the GAGEpack directory on each
individual computer where GAGEpack is installed.

To enable automatic database backups, go to Setup > Preferences > Local settings > File paths and set
Number of automatic database backups to keep to a value greater than 0.

See Also

Databases backups

Backing up an open gage database

Setting the backup directory

Setting the number of backups to be made

Backing up an open gage database

Backing up an open gage database

If the database is in use and the Backup icon is on the toolbar, the current database can be backed up by
clicking on the Backup icon. However, this requires that the database is not open for any other users.

See Also

Databases backups

Backing up gage databases on exit

Setting the backup directory

Setting the number of backups to be made

Setting the backup directory
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Setting the backup directory

The backup directory should be on a different drive from the drive used for gage database. To specify which
folder should be used to store the database backups, go to Setup > Preferences > Local settings > File
paths, and double-click on the row for Database backup. Browse to the desired folder and click OK to save.

See Also

Databases backups

Backing up gage databases on exit

Backing up an open gage database

Setting the number of backups to be made

Setting the number of backups to be made

Setting the number of backups to be made

On the File paths window just below the database paths is a box for specifying the Number of automatic
database backups to keep before discarding them. The numbers of backups can range from 0 to 9.
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See Also

Databases backups

Backing up gage databases on exit

Backing up an open gage database

Setting the backup directory

Restoring gage databases from backup

Restoring gage databases from backup

To restore a database backup, go to Utilities > Restore.

Browse to the backup file you would like to restore and click Open.
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Navigate to the location where you would like to save the new database, give it a name, and click Save.

See Also

GAGEpack files and folders

GAGEpack databases

Databases backups

Folders

Folders

Folders

When GAGEpack is installed, a series of folders is created in the installation directory.
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Backup – This is where database backup files are stored by default.

Calendar Images – The pictures used on the GAGEpack calendar are stored here. Users can change which
pictures are used by saving their own images in this folder and using the same file naming convention
(01.jpg, 02.jpg, etc)

Data – An empty folder intended to be an optional place to store the gage database file.

Documents – This folder contains a series of Word documents relevant to the use and/or setup of
GAGEpack.

Extras – This folder will be present only if GAGEmail or GAGEpack Remote are installed. The application files
necessary to run those two programs are stored here.

Gage Images – Contains a collection of sample gage images that are used in the sample gage databases.
Users can store their own gage images in this folder.

Gage Procedures – Contains a collection of sample gage calibration procedures that are used in the sample
gage databases. Users can store their own procedures in this folder.

Reports – Every report, label, management statistic, and certificate in GAGEpack is created using one of the
files in this folder. These files can be opened in any text editor.

Sample Databases – Contains two databases filled with example gage information. These databases are
included to give users an idea of what a fully operational gage database looks like. These files also contain
many example MSA study events for users to examine.

Styles - These .isl files contain the visual components that GAGEpack uses to render the user interface. They
control the color, font, gradients, shading, etc that appear throughout the software. These files are not
editable by users.

Updater – This folder contains the program PQ.Silent.Updater, which handles the automated minor version
updates. There is no reason for a user to ever launch this program. In fact, it will do nothing if launched
manually.

See Also

GAGEpack files and folders

GAGEpack databases

Databases backups
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Restoring gage databases from backup

Configuring GAGEpack

Configuring GAGEpack
In this chapter we will examine the collection of customization options that are accessible under File >
Settings.

In this chapter

Local settings

Global settings

Global collections

Supervisor

Local settings

Local settings

Any changes made to the settings in this section will only effect the current user.

In This Section

General

File paths

Reports

Barcodes

Charts

Printers

Report categories

See Also

Configuring GAGEpack

Global settings

Global collections

Supervisor

General

General

This page contains an assortment of options that are not immediately related to each other, but that
nonetheless belong in the ‘Local settingsʼ section. This page can be thought of as a collection of
miscellaneous options.
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Confirm exit from GAGEpack – If this box is checked, the user will be presented with an ‘Are you sure you
want to exit?ʼ dialogue box when closing GAGEpack.

Open the calendar on startup – If this box is checked, the calendar will automatically be displayed
whenever GAGEpack is opened.

Show catalog tab – The catalog tab is hidden by default.  It will be displayed if this box is checked.

Color-code all events in the history grid – This option refers to both the global history tab and the gage-
specific history tab found on the gage viewing form. If this box is checked, this grid will be color-coded based
on event type.

Open the gage edit form after a ‘Findʼ operation – One of the buttons on the default toolbar is ‘Find a
specific gage.ʼ This tool allows the user to type in a gage number to find it on the list. If this box is checked,
the gage form for the specified instrument will open automatically once the find operation has been
completed.

Display warning message when a calibration step fails – While completing a calibration event, if a user
enters a value that is outside of the tolerance limits, he or she will be notified with a popup box.

Print gage label after saving calibration by default – There is a checkbox in the bottom left corner of
every calibration event form labeled ‘Print gage label after saving event.ʼ If this option is enabled, the box on
the event form will automatically be checked when the form is opened.

Print certificate after saving calibration by default – There is a checkbox in the bottom left corner of
every calibration event form labeled ‘Print certificate after saving event.ʼ If this box is checked, that box will
automatically be checked when a calibration form is opened.

Language – This dropdown box allows the user to switch between the different language translations
available in GAGEpack.
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Visual style – This dropdown box allows the user to choose the visual theme of the user interface that will
be used throughout the software.

Startup filter – This dropdown will display a list of all the filters that are currently available in the active
database. If a user selects a filter from this list, GAGEpack will automatically apply that filter to the inventory
grid whenever GAGEpack is opened.

Editor for text files – This field allows the user to specify the folder path and filename for a text editing
program. This is the program that Windows will launch whenever the user tells GAGEpack to open up a text
file for editing. By default, GAGEpack will use Notepad.

Due-date processing – This series of checkboxes allows the user to tell GAGEpack which types of recurring
gage events to keep track of. Unchecking one of these events will hide the associated tabs on the gage form,
stop calculation of due dates for these events, remove the relevant color-coding from the inventory grid, and
remove the events from the to-do list, along with several other similar changes.

See Also

Local settings

File paths

Reports

Barcodes

Charts

Printers

Report categories

File paths

File paths

This page contains a collection of folder paths and filenames that represent the locations on the computer or
the network where GAGEpack is storing and looking for certain files.
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GAGEpack program folder – This is the directory where GAGEpack is installed.

Configuration file – This is the location and name of the file where GAGEpack stores most of the user-
specific preferences. This file is accessed by GAGEpack every time the software is opened (to retrieve and
apply the settings) and every time the software is closed (to save the settings). This file can be opened in
any text editor.

File paths – This table displays and allows editing of the folders where GAGEpack stores the types of files
shown in the first column. Any of these folder paths can be edited by double-clicking on the associated row.

Number of automatic database backups to keep – If the number shown in this box is greater than 0,
GAGEpack will automatically make a backup copy of the database and store it in the folder listed under the
‘File pathsʼ table shown above. GAGEpack will now allow more than N backup copies to be saved in this
folder, where N is the number displayed in the box. If saving a new backup file would result in too many
database backups, the oldest backup will be deleted.

See Also

Local settings

General

Reports

Barcodes

Charts

Printers

Report categories

Reports
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Reports

This page allows the user to adjust certain visual aspects of the reports that are generated from within
GAGEpack.

Font for   - The buttons to the right of each of these four fields open a new window that can be used to
change the font type, font size, and bold/italic states of the report text mentioned.

Table headers – Whenever a grid is generated on a report, the first row will contain column headers. This
option can be used to change the background color of this row or replace the coloring with a simple
underlining.

Watermark – The watermark is an image that will be displayed automatically on every report generated.
This box can be used to adjust three aspects of the watermark: (1) which image should be used, (2) its
position on the page, and (3) its transparency. To remove the watermark entirely, leave the first field blank
by clicking the lightning bolt icon.

Fill ‘Lastʼ field from ‘Firstʼ when entering prompts for reports – Several reports will prompt the user for
some input before being displayed. These prompts typically take the form of a range, meaning the user must
provide a ‘Fromʼ value and a ‘Toʼ value. If this box is checked, the ‘Toʼ value will be automatically populated
to match the ‘Fromʼ value. The ‘Toʼ value can be edited if necessary.

Print ALL column data in Gage list (otherwise truncate if necessary) – This checkbox refers to the report
that can be generated by right-clicking on the main inventory grid and selecting Print gage list. If this box is
checked, rows will be expanded so that the complete content of every cell is visible on the page. Otherwise,
the content will be abbreviated so that all the columns can fit.

Print the Gage List in color (if supported by printer) – If the inventory tab is color coded and this box is
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checked, those colors will be transferred to the report that is generated by right-clicking on the main
inventory grid and selecting Print gage list.

See Also

Local settings

General

File paths

Barcodes

Charts

Printers

Report categories

Barcodes

Barcodes

These settings primarily apply to barcode labels, including what type of barcode format to use, how to
respond to certain events, and what barcoded events should be included on the command page.

Barcode type – This dropdown box contains a list of all of the barcode formats that GAGEpack recognizes.
This should be configured before any gage labels or command pages are printed.

After a ‘quickʼ check-in/out – A ‘quickʼ check in/out is a special type of event whereby the user scans an
event barcode and the gage barcode and the gage is checked in/out without having to provide any extra
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information. These two options allow the user to specify the status and current location of any gage that
passes through one of these events.

Active barcode commands – This contains a list of all of the event types that can be triggered with a
barcode scan. Any event type that is checked on this list will be included on the command page when it is
printed.

Print barcode command page – This button will generate a printable report that displays a barcoded
representation of every event type that is checked on the ‘Active barcode commandsʼ list. This command
page is used to initiate gage events using a barcode scanner.

‘Quickʼ information – One of the gage events that appears on the default command page is ‘Quick
information.ʼ Scanning this event along with a gage barcode label will display a set of information about the
gage. This editable text area allows the user to specify what information should be displayed, and in what
order. The ‘@ʼ symbol identifies a macro that will be replaced with the associated value from the gage. For
example, ‘@GageNumberʼ will be replaced with the actual gage number when the quick information is
displayed. To see a list of the database names that can be used to create @Macros, go to Setup > Field
names and view the first column of the table shown there.

See Also

Local settings
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Printers

Report categories

Charts

Charts

The settings contained on this page control the look and field of the charts generated throughout GAGEpack.
The name of the setting to be adjusted appears in the left column. Settings can be edited by clicking in the
right column. In addition, the default size (in pixels) of saved chart images can be set at the bottom of this
screen.
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See Also

Local settings
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File paths

Reports

Barcodes

Printers

Report categories

Printers

Printers

This screen is used to select which printer should be used by default for printing standard documents and
which printer should be used by default for printing labels. The two lists of printers on this page are
generated by Windows, not GAGEpack. To add a printer to this list, you must add it to the list of printers
under Devices and Printers in Windows. This page can also be used to configure the margins to be used on a
standard document.
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See Also
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Report categories

Report categories

The reports list accessible from the inventory tab toolbar can be filtered by category using the dropdown box
at the top of the window. Most of the default reports have a category specified. You can view the category of
a report by selecting it from the list and clicking Edit. This will open the report file in the default text editor.
The first section (called [General]) might contain a line that says "Category=" This line identifies which
category a report belongs to.
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The Report categories page of the preferences allows users to view the default collection of categories and
create/edit their own.

See Also

Local settings
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General

File paths

Reports

Barcodes

Charts

Printers

Shortcuts

Shortcuts

This screen is used to manage the keyboard shortcuts used within GAGEpack.

Global settings

Global settings

The options contained in this section are database-wide, meaning any changes made will affect every person
using this database file.

In This Section

General

Skip dates

See Also

Configuring GAGEpack

Local settings
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Email

Gage list colors

Validation criteria

GAGEmail

Calibrations

Global collections

Supervisor

General

General

Much like the General screen under Local settings, this screen contains a collection of miscellaneous options.
The primary difference is that these options are global in scope and will therefore make changes for
everyone using the database.

Default number of uses on check-in to 1 (otherwise 0) – Gages that have a calibration interval that is
based on number of uses depend on recording the number of times the gage was used whenever it is
checked in. Some organizations prefer to simply count the number of times the gage was checked out/in
rather than counting individual uses. These organizations can check this box to have GAGEpack count each
check-in as 1 use by default. The number of uses can be edited on the check-in event if necessary,
regardless of the state of this checkbox.

Use the Gage Number as the barcode (may restrict Gage Number values) – By default GAGEpack will
encode the GageID value for a gage into the barcode labels that it generates. The GageID is a unique
identifier created behind the scenes to identify a gage throughout the software. It is almost entirely hidden
from the user because it is not relevant to most people. If this box is checked, GAGEpack will attempt to use
the Gage Number for barcodes instead. The Gage Number is the unique identifier that users create
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themselves and see whenever they interact with their gages. It is important to note that barcodes are
restrictive in what characters they allow. The vast majority of barcode formats allow only numbers.

Gage Number barcodes use a check digit - Certain barcode formats use a checksum digits to validate
the contents of the code.  Check this box to handle these types.

Company name – There are several locations throughout the software where the company name will be
displayed. Users can enter their company name in this field in order to make their own name show up in all
of these places.

Next certificate number – This field gives users the ability to edit the prefix and serialization of their
certificate numbers. When a new certificate is created, GAGEpack will increment this value by one while
retaining whatever text prefix the users have defined.

Word to use in place of ‘Gageʼ – The word ‘gageʼ is used throughout the software, but many organizations
prefer to call these ‘instrumentsʼ or ‘equipmentʼ or ‘itemsʼ or something else. By replacing the word ‘gageʼ in
this field with the desired word to use, the new word will show up throughout the software to refer to these
items.

Forbid gage check-out when – This series of check boxes can be used to block any attempt to check out a
gage that meets certain criteria. Depending on which boxes are checked, GAGEpack will not allow a check-
out event to be completed if the gage is inactive, is past due for calibration, or has failed its last calibration.

Audit trail – The audit trail records activity within the database. Whenever an event is completed or a
record is edited or a user logs in/out or some other change has been made, the audit trail will make a note
of it, including a timestamp, the name of the user who made the change, and the values before and after the
change. The audit trail can be reviewed using the global audit tab or the history tab on the gage card. This
box on the general tab can be used to turn the audit trail on or off and also to enable/configure the
automatic purge of old audit records.
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Skip dates

Skip dates are a mechanism designed to prevent gage events from being scheduled on days when the facility
is closed or no gage work is being completed for some other reason. When a due date calculation is being
performed, if the gage is scheduled for an event on a skip date, the date is moved backwards to the next
available date.
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The two grids on this page each display one month at a time. Clicking on any day in the grid will toggle that
dayʼs status as a skip day. Skip days are highlighted in teal. Users can scroll forward and backward in time
using the arrow buttons under the two grids. Clicking Now will display this month in the left grid and next
month in the right grid.

Enable skip date processing – GAGEpack will take skip dates into account only while calculating due dates
if this box is checked.

Skip Saturdays – Check this box to mark every Saturday a skip day.

Skip Sundays - Check this box to mark every Sunday a skip day.

Move dates forward instead of backward – By default, due dates that fall on skip dates are moved
backwards to the next available date. This is to prevent gage events from coming due after their original due
date. If this box is checked, dates will be moved into the future instead.
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Email

This page must be filled out in order for GAGEpack and GAGEmail to send emails. These settings tell
GAGEpack how to communicate with your mail server.

Your mail server – This is the name of the computer that handles your email traffic. If you donʼt know the
name of the mail server, ask your IT department.

Return e-mail address – This address will be displayed in the ‘Fromʼ box of the message whenever
GAGEpack sends an email. This doesnʼt have to be a real email address.

E-mail To – This address will be used by default when GAGEpack sends a message. However, every form
that sends messages offers the option to change the recipient.

Use advanced settings – Some mail servers have security settings in place that require applications to
provide valid credentials before they are given permission to send messages. If your mail server has such
security, check this box so that you can enter the username and password below. If you donʼt have a set of
credentials to use here, consult your IT department.

Port – This field stores the port number that GAGEpack will try to communicate through when it talks to the
server to send emails. It is important that GAGEpack talks through the same port that SMTP is listening to on
the server.

Username/Password – If applications must provide the server with credentials in order to send an email,
enter them here.

See Also
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Gage list colors

This page controls the color-coding used on the inventory grid.

The grid on this page has three main purposes. First, the checkboxes in the first column are used to turn the
color coding for individual gage statuses on and off. Second, the ordering of the rows on this table resolves
priority conflicts for gages that match more than one criterion. For example, using the settings in the
screenshot above, if a gage were checked out and past due for calibration, it would be colored red rather
than green, because past due for calibration is higher on the list. Third and finally, the last column is used to
change the color for the status. Click on a color to change it.

Color-code items in the inventory – The inventory grid will use the color-coding system only if this box is
checked.

Color full rows/one column - These radio buttons are used to toggle between coloring the entire row on
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the grid and coloring only a single column on the left side of the grid.

Move up/down - These two buttons are used to adjust the priority of the color-coding grid.

Defaults – This button will restore the color selection and priority order to their original settings.
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Validation criteria

Validation criteria are designed to ensure that end-users enter all required information on a form before
saving the record to the database.

To set up validation criteria, select the form you would like to configure from the dropdown list and push
Setup. This will open a blank copy of the form with green ‘Vʼ icons next to all of the securable fields.
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To enable validation criteria for an individual field, click on the green ‘Vʼ icon until the field is colored to
match the setting you would like to apply to the field. The three validation criteria settings are shown on the
main form:
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GAGEmail

The settings on this page determine how GAGEmail will behave when interacting with this database. While
GAGEmail is running, it will examine the database once every hour.
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The table at the top of the page determines which types of messages should be sent, how frequently they
should be sent, and who should receive them.

Type – There are three types of GAGEmail messages. FLC (Failed Last Calibration) messages are sent
whenever a calibration event is recorded where the overall result was ‘Fail.ʼ Past due messages show a list
of all gage events that have not been completed and are late. Coming due messages show a list of all gage
events that are within their friendly warning period, meaning they are due soon.

Send – Each message type will only be sent if the associated Send box is checked.

Period – These two columns are used together to define how frequently these messages should be sent.
FLC messages are always sent as soon as GAGEmail is aware of them.

To/Cc – These fields determine who will receive the messages. The dropdown lists contain the collection of
email addresses found under Setup > Email addresses plus one more option labeled ‘GageEmailTo.ʼ If this
option is selected the email messages will go to the person or group whose name appears in the ‘EmailToʼ
field on the general tab of the gage viewing form. Each person will receive an email that shows only his or
her own gages.

Friendly warning period in days (or 0 to use setting on gage) – This field is used to determine what
qualifies as ‘coming due.ʼ In the screenshot above, GAGEmail will send coming due notices for all gages that
are due for calibration in 30 days or less. If this value is set to 0, GAGEmail will use the FWP value found on
the general tab of the gage viewing form to determine if a gage is coming due.

Friendly warning percentage (for gages based on usage) – This field determines the uses percentage
threshold below which a gage will be flagged as coming due. In the above screenshot, GAGEmail will send
coming due notices for all gages that have less than 15% of their uses remaining.

Period to retain email history – Whenever GAGEmail interacts with the database, it will leave time-
stamped records of everything that it does. This history is stored in the database for the duration specified
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by these fields.

View history – This button will display a new window showing all GAGEmail activity currently stored in the
database.

The two lists at the bottom of the page combine to contain every gage characteristic in GAGEpack. The list
on the left shows the information that will be included in the GAGEmail messages. The list on the right shows
the other available characteristics. Users can specify the information to be included in the emails by dragging
and dropping characteristics between these two lists.

For more information about GAGEmail, please refer to the file ‘Getting Started with GAGEmailʼ found in the
‘Documentsʼ folder in the GAGEpack installation directory.
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Calibrations

This form contains most of the options pertaining to any calibrations completed in this database. It is also
used to define the acceptable temperature and humidity ranges for calibration events.
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Default overall calibration result to ‘Pass̓  – The calibration event form has a dropdown box at the top
labeled ‘Overall result.ʼ The event cannot be saved until this box contains either ‘Passʼ or ‘Fail.ʼ If this option
is unchecked, that dropdown box will default to being empty. If this box is checked, the dropdown will default
to ‘Pass.ʼ

Switch to 'Fail' on 'As Found/Left' fail - Checking these boxes will cause GAGEpack to automatically set
the overall result of a calibration based on the contents of the results grid.

Do not update the calibration due date if a calibration fails – Usually when a calibration event is
completed, GAGEpack will automatically calculate the next due date based on the calibration interval of the
gage. If this box is checked and the calibration fails, the due date is not updated but remains the same as it
was prior to the calibration.

Require record of corrective action if calibration step fails – If this box is checked, a third tab will be
added to the calibration event form. The tab is labeled ‘Actionsʼ and must be filled out if any of the ‘As foundʼ
measurements taken during this calibration failed or if the overall calibration failed.

Issue warnings before activity for any gage that failed its last calibration – If this box is checked,
GAGEpack will display a warning message whenever the user attempts to complete some event (such as a
check-out) for a gage that failed its last calibration. After acknowledging the warning, the user will be able to
continue with the event.

Require a value for ‘As foundʼ – If this box is checked, a user cannot finish completing a calibration event
until they have entered a reading in the ‘Result as foundʼ column for every step on the calibration results
grid.

Require a value for ‘After adjustmentʼ - If this box is checked, a user cannot finish completing a calibration
event until they have entered a reading in the ‘Result after adjʼ column for every step on the calibration
results grid.
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Require selection of master gage for each step – If this box is checked, a user cannot finish completing a
calibration event until they have specified a master gage for every step on the calibration results grid.

Master gage selection only includes masters linked to gage – If this box is checked, the master gage
dropdown list that appears on the calibration steps/results grid will only include master gages that are
specified on the ‘Mastersʼ tab of the gage.

Show ‘uncertaintyʼ column during gage calibration – Some regulatory agencies require that calibration
tables display a column to record the uncertainty value of the associated step. By default this column is
hidden but checking this box will cause the column to appear on the ‘Calibration stepsʼ tab of the gage form
and the ‘Calibration resultsʼ tab of the calibration event form.

Temperature – The toggle is used to choose between Centigrade (Celsius) and Fahrenheit. The min and
max fields define the lower and upper limits of the allowable temperature range, respectively.

Humidity - The min and max fields define the lower and upper limits of the allowable humidity range,
respectively.

Extreme values? – When a temperature or humidity value that is beyond the allowable range is entered
into a calibration event form, GAGEpack will respond in one of these three ways.
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This area of the preferences interface contains "lists of things." Every page allows the manipulation
(add/edit/delete) of the contents of the list associated with that page.

In This Section

Parts

Users

Vendors

Devices

Choice lists

Field names

Email addresses

Event userfields

User-defined fields
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Maintenance tasks

Maintenance plans

Divisions

Parts

Parts

GAGEpack allows each gage to be associated with a collection of parts (those parts for which it is used to
measure). Each part may need a number of gages to measure it. To manage this situation, GAGEpack
maintains a matrix to cross-reference gages with parts. Access to this matrix is through the Parts tab on the
Gage editing window.

This page in the preferences window manages the list of parts on which gages in the database might be
used. Parts must be added to this list before they can be referred to by gages.

These parts can be referred to on the parts tab of the gage viewing form or on check in/out events.
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As you navigate the list of parts, you may notice that a list of gages appears in the box marked Other gages
associated with this part. These are the gages that can be used as substitutes for that job if a gage is in
use or otherwise unavailable.

Three default reports are concerned with parts in the database.

See Also

Global collections
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Users

Users

This page is used to manage the set of usernames that GAGEpack recognizes as having access to the
database. (Note that this list is relevant only if the database security level is set to Username login only or
Full login required. For more information about this, see the section ‘Login optionsʼ below.) Before users
can select their name (and provide a password depending on the security level) from the initial login screen,
they must be added to this list of users.

Add – This button will open a window that allows for the creation of a new user.
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The Name and Password of the new user are entered in the provided fields at the top of the form.

The two"rights" tabs on this form contain checkboxes that enable or forbid this new user from performing
the specified actions within the database. The Access rights tab is concerned with the userʼs ability to
View/Add/Edit/Delete certain GAGEpack objects (such as gages, vendors, events, etc). The Other rights tab
deals with the userʼs ability to interact with certain utilities and options throughout the software. The
Divisions tab is used to add/remove this user to/from existing partitions of the database. All of these can be
enabled or disabled on an individual basis by checking/unchecking the appropriate boxes.

The form contains a series of buttons along the bottom that are useful for quickly assigning a user to a
common configuration of access privileges:

All – Checks every box on both tabs. This user will have the rights to do everything except manipulate the
security level of the database.

None – Un-checks every boxy on both tabs. This user will be able to do little more than open the database
and view the main lists (without the ability to open any items).

Default – This user will be able to view, add, and edit all objects except Users, and unable to delete
anything. The user will also not have rights to any utilities other than viewing and printing reports.

View only – This user can examine everything in the database, but cannot add, edit, or delete anything.

Note: These four buttons switch the check-boxes to only these pre-defined states. Afterward, any of the
boxes can be checked or unchecked as necessary.

Once the username and password have been entered and the rights have been defined, click OK to save this
new user to the database.
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Edit – Selecting a user and clicking this button will open a window that displays the current access privileges
enjoyed by this user. From here these privileges can be adjusted as necessary and any changes will be
saved by clicking OK.

Copy – Selecting a user and clicking this button will create a new user that is an exact replica of the
originally selected user except for the name and password.

Delete – Selecting a user and clicking this button will remove the user from the list of active users in the
database.

Note: A deleted username still exists in the database; it is just hidden. This is to maintain the integrity of
historical records that might refer to the user. Since that is the case, it is not possible to create a new user
who has the same name as a previously deleted user. It is therefore recommended that users are created
with a first and last name to avoid naming conflicts.

Note: It is possible to ‘un-deleteʼ a user. Please contact PQ Systems tech support for assistance.
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Vendors

This collection stores the names and contact information for third party companies that are somehow
associated with the gages in the database. This page of the preferences window is used to add, edit, or
delete vendors.

Add – This button will open a window that allows for the creation of a new vendor.
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To create a new vendor, simply fill out this form with all available information and click OK to save. Most of
the fields on this form are pretty straightforward. However, there are a few that warrant further explanation.

Id – This field is not editable by the user. It refers to the unique identifier that GAGEpack assigns to this
vendor once it has been created, and is here because there are a few (albeit not many and not prominent)
places where vendors must be referred to by their vendor Id number. This field will be blank while the
vendor is being created, but will be populated as soon as this form is saved.

Vendor type(s) – Throughout the software there are three different types of vendor dropdowns that appear.
These types are Purchase, Service, and Calibration. These checkboxes can be used to put a vendor on only
the vendor lists where they belong.

Certification – This table is used to keep track of the vendorʼs certified compliance with industry standards.
Once the standards have been added to this list, the to-do list on the tasks tab will remind users when
vendor certifications are due to expire.

Edit – Selecting a vendor and clicking this button will open a window that displays the current contact
information and settings for the vendor. This information can be adjusted as necessary and any changes will
be saved by clicking OK.
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Copy – Selecting a vendor and clicking this button will create a new vendor that is an exact replica of the
originally selected vendor except for the name.

Delete – Selecting a vendor and clicking this button will remove the vendor from the list of active vendors in
the database.
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Divisions

Devices

Devices

GAGEpack has the ability to capture gage data directly from a device connected to the computerʼs COM port
(or a USB configured as a virtual COM port). This mechanism can be used with any event that uses gage
data (calibration, R&R study, linearity, uncertainty, and stability). This page of the preferences window is
used to manage the collection of devices that will be feeding data into GAGEpack using this mechanism.

Add – This button will open a window that allows for the creation of a new device.
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To add a device, give it a meaningful name and select the appropriate options from the dropdown boxes.
This connection information should be provided in the documentation included with your gage. If not, please
contact the gage manufacturer.

Once the connection information has been entered, click Test on this form and the Send button on the gage.
The Click and drag to create an input mask field should display a readout of the signal sent from the
gage. Use the mouse to highlight the section of the readout that contains the meaningful measurement.

Click OK to save.

Edit – Selecting a device and clicking this button will open a window that displays the current settings for the
device. This information can be adjusted as necessary and any changes will be saved by clicking OK.

Copy – Selecting a device and clicking this button will create a new device that is an exact replica of the
originally selected device, except for the name.

Delete – Selecting a device and clicking this button will remove the device from the list of active devices in
the database.

To associate a gage with a device, open the gage form for the gage and go to the Calibration steps tab.
Select the device from the dropdown list at the bottom of the tab.
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Once the device has been created and associated with a gage record in the database, it can be used during
any supported event involving this gage. Simply click in the field on the event where you would like the value
recorded and click the Send button on the device.
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Choice lists

Choice lists

Choice lists contain the content of many of the dropdown windows that appear throughout the software. This
page provides the ability to manage these lists.
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Add – This button will open a window that allows for the creation of a new choice list. User-created choice
lists can be used to add dropdown content to user-defined fields and event user fields.

Edit – Selecting a choice list and clicking this button will open a window that displays the current contents of
the list. The list can be adjusted as necessary and any changes will be saved by clicking OK.
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Delete – Selecting a choice list and clicking this button will remove the choice list from the list of active
choice lists in the database. Note that ‘Systemʼ choice lists cannot be deleted.

Note: Please see the utility Load choice lists from gages for an easy way to build choice lists based on the
contents of the gages.
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Field names

All of the gage characteristics can be renamed to better suit the needs of an organization. This page is used
to make these changes. Whenever a gage characteristic has been renamed, the new name will immediately
appear throughout the software where the old name used to be.
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The grid on this page has three columns:

Database name – Most users will have no need of this column whatsoever. It shows the name of the field as
it appears in the database behind the scenes. This is useful for writing custom queries, but has little
application for a typical user. This column is read-only.

Default value – This column shows the name that this field uses in its original state. This column is also
read-only.

Name – This column displays the name of the characteristic that will appear throughout the software. This
column can be edited by the user. To rename a column, simply erase the previous name and type in a new
one.

Defaults – This button will cause the Name column to match the Default value column exactly.
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Email addresses

Emails can be sent from several locations in GAGEpack. GAGEmail also retrieves email addresses from the
database. This page is used to define the list of email contacts that are available for use in these locations.

There are two types of objects managed on this page. The first type is a ‘contact,ʼ which is a single name
and associated email address. The second is a ‘group,ʼ which is a collection of contacts clumped together for
the purpose of sending a single message to a whole bunch of people.

Both of these types of objects can be used as recipients for GAGEpack and GAGEmail emails, and both can be
created, edited, and deleted using this interface.

New contact – To create a new email contact, click this button and enter the name and email address of the
contact when prompted. Click OK to save.
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New group – To create a new email group, click this button. The section at the bottom of the page will
unlock to allow contacts or groups to be dragged from the main table into it. Once all desired contacts have
been dragged into the group, click Save group and give the group a name.

Edit – Selecting an email contact or group and clicking this button will allow changes to be made to it.

Delete – Selecting an email contact or group and clicking this button will remove it from the list.
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Event userfields

Every type of gage event form contains two UserFields. These provide users with a place to store
information about the event that doesnʼt already have a field dedicated to it. This page of the preferences
window allows these fields to be renamed and linked to choice lists.
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The grid on this page has three columns.

Event – This column identifies which gage event type is associated with the two user fields that appear on
the same block of two rows. This field is not editable.

User field name – This column displays the current label being used on the event user fields. Users can re-
label these fields by simply deleting the existing text and typing in something else.

Choice list (optional) – Each of these fields has the ability to offer the user options in the form of dropdown
lists. This column contains a dropdown list that shows all of the available choice lists in the database. Users
can associate a choice list with a user field by simply selecting the desired choice list from this dropdown. In
addition, new choice lists can be created from this screen by clicking New choice list.
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Maintenance plans

Divisions

User-defined fields

User-defined fields

Fourteen gage characteristic fields have been intentionally left ambiguous. These exist to allow users to
store gage information that does not already have a field dedicated to it. This page of the preferences
window allows these fields to be renamed and linked to choice lists.

User field name – This column displays the current label being used on the user fields. Users can re-label
these fields by simply deleting the existing text and typing in something else.

Choice list (optional) – Each of these fields has the ability to offer the user options in the form of dropdown
lists. This column contains a dropdown list that shows all of the available choice lists in the database. Users
can associate a choice list with a user field by simply selecting the desired choice list from this dropdown. In
addition, new choice lists can be created from this screen by clicking New choice list.
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Maintenance tasks

Gages can be scheduled for routine active maintenance events by adding tasks to their PM tasks list (found
on the gage viewing form). This page of the preferences allows for the management of the list of tasks that
are available to be used on the gages.

Add – This button will open a window that allows for the creation of a new maintenance task.
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To add a task, give it a meaningful name and description and define the frequency with which it should be
completed. Attached a document to the task if necessary. Click OK to save.

Edit – Selecting a task and clicking this button will open a window that displays the current settings for the
task. This information can be adjusted as necessary and any changes will be saved by clicking OK.

Copy – Selecting a task and clicking this button will create a new task that is an exact replica of the
originally selected task except for the name.

Delete – Selecting a task and clicking this button will remove the task from the list of active tasks in the
database.
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Maintenance plans

Maintenance plans

Maintenance plans exist to make it easy to attach many maintenance tasks to a gage at once. A maintenance
plan is simply a collection of maintenance tasks that have been clumped together for easy deployment. This
allows for the management of the collection of maintenance plans.
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Add – This button will open a window that allows for the creation of a new maintenance plan.
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To add a plan, give it a meaningful name and drag all desired maintenance tasks from the list on the bottom
to the space at the top. Click OK to save.

Edit – Selecting a plan and clicking this button will open a window that displays the current tasks associated
with this plan. This information can be adjusted as necessary and any changes will be saved by clicking OK.

Copy – Selecting a plan and clicking this button will create a new plan that is an exact replica of the
originally selected plan except for the name.

Delete – Selecting a plan and clicking this button will remove the plan from the list of active plans in the
database. The tasks associated with the plan will not be deleted.
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User-defined fields
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Divisions

Divisions

Divisions give the GAGEpack database administrator the ability to break up the organizationʼs gage inventory
into logical segments based on department, geographical location, or any other attribute. These logical
segments are called "Divisions." Users and gages can both be added to divisions. In any database where
Divisions are enabled, any user that logs into the system will be able to see and interact only with the gages
that belong to the same divisions that the user belongs to as well.

Add – This button will open a window that allows for the creation of a new division.
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To create a new division, enter a name and check the boxes next to the users that will be associated with it.

Edit – This button will open the selected division so the name or the member users can be changed.

Delete – This button will delete the selected division. Gages currently in this division will revert to a state of
not belonging to any division, and so will be visible by every user.

Users can also be added to divisions from the user-edit window.
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Gages can be added to divisions from the General tab of the gage form.
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Supervisor

This section of the preferences window is visible ONLY while logged in using the account called
SUPERVISOR. No other users, even those with all rights enabled, can see this area.

In This Section

Login options

Corporate settings

Corporate reports

See Also

Configuring GAGEpack

Local settings

Global settings

Global collections

Login options

Login options

This page controls the security level being used in the current database. There are three distinct levels of
security.
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No login required. Each user will be treated as SUPERVISOR, and no login form will appear when
GAGEpack starts.

Username login only. On entry to GAGEpack, the user will be required to enter a name that will be used as
an identifier for various activities. Each user will have SUPERVISOR rights.

Full login required. Each user will be required to enter a valid GAGEpack username and matching
password. Rights will depend on those allocated by GAGEpackʼs SUPERVISOR.

Password expiry time (days) – This field is used to define how long a password is valid before it has to be
changed.

See Also

Supervisor

Corporate settings

Corporate reports

Corporate settings

Corporate settings

Corporate settings are global (database-wide) configuration options which, if enabled, will override their
local equivalents. For example, if an administrator wants every GAGEpack user to utilize a shared Reports
folder on a network drive, he needs to enable corporate file paths and select the folder. This will override
any folder selection that users make at the local level.



GAGEpack

89 / 298

See Also

Supervisor

Login options

Corporate reports

Corporate reports

Corporate reports

If enabled, these report settings will override the report settings for all users of this database.
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See Also
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Login options
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Gage management
This chapter covers the various ways to view, add to, edit, manipulate, and organize the collection of gages
stored in a GAGEpack database.

In this chapter

Gage form

Adding a gage

Editing a gage

Deleting a gage

Copying a gage

Cloning a gage

Finding a specific gage
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Search and replace

Filters

Reports

Views

Gage form

Gage form

The Gage editing form is used to view and edit information about a specific gage. To access this form, 
double-click on a gage from the Gages tab. This form has several tabs that represent different categories of
gage information:

§ The General tab is used to record basic information about the gage.
§ The History tab is a record of past events and activities for the gage.
§ The Calibration tab is used to set the frequency at which calibration events are scheduled for the

gage. This tab also contains the calibration procedure.
§ The Masters tab displays the collection of master gages associated with this gage
§ Use the Calibration steps tab to define the target and allowable variance for each of your calibration

ranges.
§ The R&R tab sets the frequency at which R&R study events are scheduled for the gage. This tab also

contains the R&R procedure.
§ The Maintenance tab sets the frequency at which maintenance events are scheduled for the gage.

This tab also contains the maintenance procedure.
§ The PM tasks tab defines which preventative maintenance procedures must be performed on the

gage during a maintenance event.
§ Use the Vendors tab to enter information about the vendor(s) that sold, services, or calibrates the

gage.
§ The User fields tab is used to enter data in fields defined by your organization.
§ The Documents tab references any external file from within the gage. This tab also stores the

location of a gage image file.
§ The Parts tab can be used to enter part names (or any other designation desired such as job
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number) that the gage is used on. There are reports that summarize the parts assigned to a gage
and the gages assigned to a part.

See Also

Gage management

Adding a gage

Editing a gage

Deleting a gage

Copying a gage

Cloning a gage

Finding a specific gage

Search and replace

Filters

Reports

Views

Adding a gage

Adding a gage

To add a new gage:

1. Click on the Add gage icon on the Inventory toolbar. You can also right-click on the gage list and
select Add gage from the pop-up menu. The Gage editing form will open.

2. In the top left corner, replace "New number" with a name/number for the new gage. This will be the
gage number that distinguishes gages from each other, so no two gages can share the same number.

3. Enter as much information as is available into the gage form tabs. All of the fields are optional. Only
the gage number must be entered for a device to exist in the database. The topics that follow provide
more information on each of the tabsʼ fields.

NOTE: If several gages have similar settings, the user may find it advantageous to copy the gage, create a
template that can be copied repeatedly, or clone an existing gage. These features are discussed later in this
chapter.
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General

General

The following descriptive fields are available through the General tab. Several fields have choice lists
associated with them. These drop-down options can be edited by double-clicking on the drop-down button.
All of the fields on the General tab are customizable. For more information about editing choice lists and
field names, please see Configuring GAGEpack.
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§ Gage type: Enter the type of device in this field. Type in the gage type or select a gage from the
drop-down menu choice list.

§ Gage size: Type the gage size in this field.
§ Minimum: Enter the minimum value of the gageʼs measuring range.
§ Maximum: Enter the maximum value of the gageʼs measuring range.
§ Units of measure: Enter the units of measure for the gage into this field.
§ Gage description: Type a description of the device in this field.

Status: Enter the status of this gage into the field.

Current location: Enter the current location of the gage into this field.

Storage location: Enter the storage location of the gage into this field.

§ Division: Gage databases can be broken up into logical segments called "divisions." Once divisions
have been created and enabled (Setup > Preferences > Global collections > Divisions), this dropdown
can be used to assign a gage to a division.

§ Group: Gages can be grouped together to allow related gages to be easily accessed via filters and
reports. A group of gages can also be checked in or checked out with a single event. Use this field to
assign the gage to a specific group.

§ NIST number: Use this field to record National Institute of Standards and Technology numbers.

Accuracy: The value entered is generally based on the smallest increment that can be read on the gage (for
example, 0.00001, 0.0001, or 0.001).  

FWP in days: Friendly Warning Period - Use this field to set how far in advance of an event a warning should
be dispatched. Use "0" to deactivate the warning.

§ Active: If a gage is active, put a check in this box. An active device is one that is currently in
circulation, although not necessarily currently in use. An inactive device is one that is out of use
indefinitely, but could be reactivated.

Use as a master gage: Check this box if this is a master gage. A master gage is a device used to calibrate
other devices. Also known as a company standard, AIAG refers to this as a primary or secondary standard.

Due dates are recalculated daily: Check this box if you want the amount of time remaining until the next
due date to count down only while the gage is checked out. A "checked-in" gage with this box checked will
not be moving towards its next due date.
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§ Move due dates to end of month: If this box is checked, calibration, maintenance, and R&R study
due dates will be moved to the last available day of the month in which the due date would otherwise
be scheduled.

§ Used as a go/no go device: Check this box if this device returns a go/no go result rather than a
measurement.

§ E-mail to: Use this field to set which person should receive e-mail alerts concerning the gage.
§ Comment: Enter general notes about the gage into this field.

See Also

Adding a gage
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History

History

This tab displays every event in the database that is associated with this gage. For a new gage, it will be
empty. Nothing needs to be done on this tab while adding a gage. The tab will be populated with events
throughout the gage's life. Users with appropriate privileges can add, edit, or delete events from this screen.
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See Also

Adding a gage
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Calibration steps

R&R
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User fields

Documents

Parts

Calibration

Calibration

Use this tab to set frequency of calibration for this gage. The interval can be based on time, number of uses,
a combination of both, or a date entered manually. A brief explanation of each method is given below.

§ Time: Use this option to set how much time can elapse between calibration events. Note that the Due
dates are recalculated daily option on the General tab can effect this, if enabled.

§ Uses: With this method, due dates are calculated by comparing the number of times that the gage
has been used to the target number of uses. When the number of uses equals or exceeds the target
count, then the due date will be today. If the number of uses is less than the target count, the next
due date is not specified. You can enter the number of times a gage has been used when you check a
gage in or by using an Other event.

§ Time and uses: Using this method, the due date will be the earlier of the Time date and the Uses
date. The due date will be based on time unless the number of uses is exceeded before the time has
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expired.
§ Manual: No calculations are performed using this method. The due date is simply entered by the

user.
§ Calibration procedure: Instructions for calibrating this gage may be typed or copied into the

Calibration procedure field. Since this field may be edited and any changes made must be done on
this screen, the user may prefer to designate a file that can be used by more than one gage and
cannot be readily changed. Files containing calibration procedures may be accessed by entering the
file name and path into the Name of file containing calibration procedure. This field is optional.
These files and the typed in procedure may be displayed when calibrating a gage.

§ Gage is calibrated externally: Select this option to designate the gage as calibrated externally. If
this option is selected, the Calibration steps tab will be disabled.

See Also
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Masters

Use this tab to specify the collection of master gages associated with this gage.
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To edit the list, click Change. Check the boxes next to the master gages that should be included.

See Also
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Vendors

User fields
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Documents

Parts

Calibration steps

Calibration steps

Use this tab to enter the steps required for calibrating the gage.

In This Section

Adding calibration steps

Deleting calibration steps

Reordering calibration steps

Entering data coding values

Selecting a device

Copying calibration steps

Creating a calibration steps template

See Also
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Documents
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Adding calibration steps

Adding calibration steps
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To enter calibration steps:

1. Select the Calibration steps tab on the gage form for which the calibration steps are to be entered.

2. Enter a name for the step in the Name column.

3. If the step is to evaluate attributes data, put a check in the Is atr column.

4. Enter the target value for this step in the Target column. If you entered Yes in the Is atr field, you can
enter text (such as Pass or Yes) in the Target field.  If you type the target value in during a calibration
event, it will Pass if it matches and Fail if it doesn't.

5. Enter the units used in the measurements. (optional)

6. If the specification limits are equidistant from the target, enter the allowable variance in the
Plus/Minus field and GAGEpack will determine the Max and Min values for you. If not, you can enter
the acceptance values for this gage in the Max and Min fields. See steps 7 and 8.

7. In the Max field, enter the highest acceptance value for this gage.

8. In the Min field, enter the lowest acceptance value for this gage.

9. In the ndp field, enter how many significant digits should be displayed after the decimal point. ndp
stands for Number of Decimal Places.

10. In the Master gage field, a master gage can be selected for each step from a choice list of all
designated masters if desired. (optional)

11. Repeat steps 2 through 10 until all of the steps have been entered.

See Also

Calibration steps

Deleting calibration steps

Reordering calibration steps

Entering data coding values

Selecting a device

Copying calibration steps

Creating a calibration steps template

Deleting calibration steps

Deleting calibration steps

To delete a calibration step:

1. Highlight the step to be deleted.

2. Click Delete and the step will disappear without asking for confirmation.

See Also

Calibration steps

Adding calibration steps

Reordering calibration steps

Entering data coding values

Selecting a device

Copying calibration steps
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Creating a calibration steps template

Reordering calibration steps

Reordering calibration steps

To change the order of the calibration steps, select the step to be moved by clicking on it, then use the
up/down arrows at the bottom of the page to move it.

See Also

Calibration steps

Adding calibration steps

Deleting calibration steps

Entering data coding values

Selecting a device

Copying calibration steps

Creating a calibration steps template

Entering data coding values

Entering data coding values

Once you have entered the target value and a plus/minus or acceptable high or low values, you can enter a
data coding value. This feature is based on the gage increment; it simplifies the data entry process.

1. Click on the down arrow in the Increment box and a list of increment values will appear.

2. Select the appropriate increment value given the target and gage increment.

3. The selected value will appear in the Increment box ready for use when doing a calibration on this
gage.

See Also
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Calibration steps

Adding calibration steps

Deleting calibration steps

Reordering calibration steps

Selecting a device

Copying calibration steps

Creating a calibration steps template

Selecting a device

Selecting a device

This dropdown will display a list of all of the devices currently configured under Setup > Preferences >
Global collections > Devices. Use it to associate one of those devices with this gage.

See Also

Calibration steps

Adding calibration steps

Deleting calibration steps

Reordering calibration steps

Entering data coding values

Copying calibration steps

Creating a calibration steps template

Copying calibration steps

Copying calibration steps
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1. Make sure that you have the Calibration steps tab displayed for the gage to which you want to copy
the steps.

2. Click Copy steps. The Copy calibration steps from window will open.

3. Highlight the number of the gage from which you want to copy the calibration steps.

4. Double-click on this gage number or click Select to copy the steps to the current gage.

See Also

Calibration steps

Adding calibration steps

Deleting calibration steps

Reordering calibration steps

Entering data coding values

Selecting a device

Creating a calibration steps template

Creating a calibration steps template

Creating a calibration steps template

The copy steps function allows the user to copy calibration steps to a selected gage from another gage. The
template provides the same copy feature without using a gage. The advantage is that the template name
can be descriptive of what gages the steps are suited for. In general, a template is made from steps that
have been entered for an existing gage.

In This Section

Creating a calibration template from an existing gage

See Also

Calibration steps
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Loading a calibration template

Deleting a calibration template

Adding calibration steps

Deleting calibration steps

Reordering calibration steps

Entering data coding values

Selecting a device

Copying calibration steps

Creating a calibration template from an existing gage

Creating a calibration template from an existing gage

To create a calibration template from an existing gage:

1. Open the gage form for the gage you want to use to make a template.

2. Click on the Calibration steps tab to display the steps you want to make into a template.

3. Click Templates, and the Calibration templates dialog box will be displayed.

4. Click Save, and the Template name dialog box will be displayed.

5. Enter the name for the template.

6. Click OK, and the Template name dialog box will close saving the template

7. Click Close to close the Calibration templates dialog box.

See Also

Creating a calibration steps template

Loading a calibration template

Deleting a calibration template

Loading a calibration template
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Loading a calibration template

To load a calibration template:

1. Open the gage form for the gage you want to apply the calibration template.

2. Click the Calibration steps tab.

3. Click Templates, and the Calibration templates dialog box will be displayed.

4. Select the calibration template to be used for this gage.

5. Click Load, and the confirmation dialog box will be displayed.

6. Click Yes and the calibration steps will be copied to the gage.

See Also

Creating a calibration steps template

Creating a calibration template from an existing gage

Deleting a calibration template

Deleting a calibration template

Deleting a calibration template

To delete a calibration template:

1. Open a gage form and select the Calibration steps tab.

2. Click Templates, and the Calibration templates dialog box will be displayed.

3. Select the calibration template to be deleted.

4. Click Delete, and the confirmation dialog box will be displayed.

5. Click Yes, and the calibration steps will be deleted.

See Also

Creating a calibration steps template
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Creating a calibration template from an existing gage

Loading a calibration template

R&R

R&R

The R&R tab is almost identical to the Calibration tab in form and function. The only difference is that it
contains the interval and procedure for R&R studies instead of calibration events.
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Maintenance
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The Maintenance tab is almost identical to the Calibration tab in form and function, but it contains the
interval and procedure for maintenance events instead of calibration events.

See Also

Adding a gage
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Parts

PM tasks

PM tasks

This tab can be used to schedule and track any number of individual maintenance actions for the gage. This
feature is independent of the existing preventive maintenance system.
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To add PM tasks to a gage:

1. Click Change in the bottom right corner.

2. Check the boxes associated with the tasks you would like to add to this gage, then click OK.

3. The tasks will be added to the gage. Use the calendar dropdown in the Due date column to specify
when the first occurrence of this task should take place.
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Vendors

The Vendors tab is used to enter information about the vendor(s) that sell, service, and/or calibrate the
gage. All of the fields on this tab are optional. Vendors can be added to the drop-down lists by going to File
> Settings > Global collections > Vendors.
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User fields

User fields allow the user to create and save up to fourteen additional pieces of information about the gage
(ten text fields and four Boolean fields). The user fields themselves are set up elsewhere in the program
(see Setup > User defined fields), but this tab is used to populate the fields for this particular gage.
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Documents

The Documents tab is used to associate an image and/or any external file with the gage. If an image file is
selected, it will be displayed on this form.
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Parts

This tab is used to identify which parts this gage is used to measure. For information about creating the list
of parts in the database, please see Configuring GAGEpack.
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To associate parts with this gage, click Edit and then check the boxes for the appropriate parts. Click OK to
save.

See Also
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Maintenance

PM tasks

Vendors

User fields

Documents

Editing a gage

Editing a gage

To edit a gage, double-click on the gage from the inventory tab to open the gage form. If you have sufficient
user rights, you can make any necessary changes to the fields on the form. Click OK to save.

See Also
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Deleting a gage

Deleting a gage

To delete a gage listing:

NOTE: When you delete a gage from the gage list, you delete all information related to that gage. There is
no "undo" function or second chance to recover the gage. Make a backup of the gage database before you
delete a gage.

1. Highlight the gage that you want to delete.

2. Right-click on the gage list and select Delete gage to delete the highlighted gage.  Or click Delete in
the ribbon bar.



GAGEpack

115 / 298

3. You will be asked to confirm the deletion. Select Yes to delete or No to cancel.

To delete multiple gages, click and drag to highlight all of the gages to be deleted, then right-click and select
Delete.
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Copying a gage



GAGEpack

116 / 298

This function creates a new gage that is an exact duplicate of an existing gage. The new gage will share all
of the characteristics of the gage that is copied, except for history events.

To copy a gage:

1. Highlight the gage on the gage list and click Copy gage from the ribbon bar.

2. The Gage editing form will open and you will be prompted to enter a name for the gage.
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3. Enter the appropriate gage number.

4. Make any desired changes.

5. Click OK.
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Cloning a gage

Clone gage is similar to Copy gage in that it will create new gages by copying all the characteristics of an
existing gage, except for history events. The difference is that cloning a gage can generate many new gages
at once.

To clone a gage:

1. Highlight the desired gage on the gage list and click Clone gage from the ribbon bar.
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2. You will be prompted to enter a Name prefix, a Starting number (extra digits will not be used -
0001> 1), the Number of digits to appear in the name (0000), and the Number of copies to create.

3. Click OK, and the Clone completion dialog box will display the number of gages created.

4. Click OK, and both the Clone completion dialog box and the Clone gage dialog box will close. 
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Finding a specific gage

From the Inventory tab, there are two options for finding a gage.

Option 1 (basic)
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1. Click on the Find by gage number icon from the ribbon bar.

2. Enter the number of the device that you want to find. Also, you can scroll through the list of gages
provided through this window, and highlight the name of the gage that you want.

3. Click Select. You can also double-click on the gage name to select the gage.

Option 2 (advanced)

Use this option to search for a gage or group of gages using a more complex set of criteria.

From the ribbon bar, select Find advanced.

1. Set your search criteria.

2. Click Search. Gages that match the search criteria will be listed in the grid at the bottom of the form.
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Search and replace

The ‘Search and replaceʼ family of utilities is used to make mass changes to the gage inventory. Each of the
four utilities described below will make the prescribed change to every gage currently visible on the Gages
grid. Gages that are hidden from the Gages grid using a filter will not be changed.



GAGEpack

121 / 298

In This Section

Basic

Calibration templates

PM plans

Master gages

See Also

Gage management

Gage form

Adding a gage

Editing a gage

Deleting a gage

Copying a gage

Cloning a gage

Finding a specific gage

Filters

Reports

Views

Basic

Basic

The standard ‘Search and replaceʼ utility will change the contents of a single field for every gage currently
visible on the inventory grid.

In this screenshot, a filter is being used to show only gages that are past due for calibration. By clicking
Make the change here, these 2 gages will have their Status changed to ‘Out for Calibration.ʼ.

Note: There is no way to undo changes made by search and replace. Be careful.

See Also

Search and replace

Calibration templates

PM plans



GAGEpack

122 / 298

Master gages

Calibration templates

Calibration templates

The calibration templates ‘Search and replaceʼ utility will update the calibration steps of all the gages
currently visible on the inventory grid so that they match the contents of the specified calibration template.

In this screen shot, a filter is being used to show only calipers. When Apply is clicked, the calibration
template called "4" Caliper" will be applied to those 15 calipers.

Note: There is no way to undo changes made by search and replace. Be careful.

See Also

Search and replace
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PM plans

Master gages

PM plans

PM plans

The PM (Preventative Maintenance) plans ‘Search and replaceʼ utility will update the PM tasks lists of all the
gages currently visible on the inventory grid so they match the contents of the specified PM plan.
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In this screen shot, a filter is being used to show only calipers. When Apply is clicked, the PM plan called
"Calipers" will be applied to those 15 calipers.

Note: There is no way to undo changes made by search and replace. Be careful.

See Also
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Master gages

Master gages

The master gages ‘Search and replaceʼ utility will update the master gage references of all the gages
currently visible on the inventory grid so they match those masters selected by the user.



GAGEpack

124 / 298

In this screen shot, a filter is being used to show only calipers. When Apply is clicked, the master gage
‘Master-06002ʼ will be added as a reference to those 15 calipers. Any previously existing master gage
references on these gages will be replaced.

Note: There is no way to undo changes made by search and replace. Be careful.

See Also
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Filters

Filters allow the user to configure the main inventory grid by having it display only the gages that match a
certain set of criteria. To access the filters interface, go to the Inventory tab and click the Filters icon on the
toolbar.
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Time-frame filters

Applying a filter
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Adding a filter

To create a new filter, click Add. This will open a blank filter definition window.
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In order for a filter to function properly, three things must be present in the filter definition:

Field – This is the gage characteristic that the filter will examine when trying to decide if a gage should be
included. Any and every gage characteristic can be used in a filter.

Comparison – ‘is equal to,ʼ ‘is greater than,ʼ ‘does not equal,ʼ etc

Value – The input against which the contents of the specified gage characteristic will be evaluated. In many
cases, this column will offer a dropdown list of available options.

When applied to the inventory grid, the filter in the screen shot below will show only active gages that are
stored in the Tool Crib.
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Applying a filter

Wild-card filters

Wild-card filters

Filters can be configured to return results based on a part of a text field, rather than matching the whole
field. This is done by using the ‘is likeʼ value in the Comparison dropdown in conjunction with the ‘%ʼ symbol
as the wild card.

When applied to the inventory grid, the filter in the screenshot below will show all of the gages that have
gage numbers that begin with the letter ‘C.ʼ
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Applying a filter

Time-frame filters

Time-frame filters

When a filter condition is used to examine a date field (such as ‘CalibDueDateʼ or ‘LastCalibDateʼ), the Value
dropdown will offer a series of @macros which can be used to retrieve the current date and time from the
computer. This is extremely useful because it means that filters concerned with a particular time frame
relative to ‘todayʼ never have to be updated once they are created.

When applied to the inventory grid, the filter in the screen shot below will show all of the active gages that
are due for calibration within 30 days from "today" (where "today" is whatever day the filter is applied to the
grid).
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Notice that the @macro in conjunction with a (+/-) and a number can be used to move the date into the past
or the future. This formula can be used to refer to any number of time frames. Here are some examples:

@ThisMonth-2: Two months ago

@ThisWeek+4: Four weeks in the future

@ThisYear+1: One year in the future

@Today-7: Seven days ago

See Also

Filters

Adding a filter

Wild-card filters

Applying a filter

Applying a filter

Applying a filter

Once a filter exists, there are several different ways to apply it.

The first and most accessible is to select the filter from the dropdown list that appears in the global filter
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panel on the right side of the screen.

A second option is to open the filters list, select the filter, and click Apply.

Finally, a filter can be applied in conjunction with other features, such as Views and Local settings (start-up
filter).

See Also

Filters

Adding a filter

Wild-card filters

Time-frame filters
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Reports

Reports

Reports are designed to extract useful information from any part of the database and display that
information in a well-formatted way. Given such a loose definition, reports are extremely flexible in that they
can inform the user about anything of interest in the database and can be shared in a number of different
ways. The reports list can be accessed from the Home tab of the ribbon bar.

In This Section

View a report

Email a report

Save a report to a file

Create a new report

Edit a report

My Reports

See Also

Gage management

Gage form
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Editing a gage
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Copying a gage

Cloning a gage

Finding a specific gage

Search and replace

Filters

Views

View a report

View a report

By default, there are approximately 150 reports included in GAGEpack when it is first installed. These, along
with any new reports created by the user, can be generated and displayed by selecting a report from the list
and clicking Preview.
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In This Section

Prompts

See Also
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Email a report

Save a report to a file

Create a new report

Edit a report

My Reports

Prompts

Prompts

Many reports will ask the user to provide some information in the form of parameters before the report is
generated. These parameters are used to define the range of what will be displayed on the report. These
are called prompts.
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Leaving a prompt field blank will cause the associated parameter to be ignored.

See Also

View a report

Email a report

Email a report

Reports can be sent as an email attachment by selecting the report from the list and clicking E-mail.
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The user will be able to enter any required prompts information, and then will need to specify who should
receive the email and what the body of the message should say.

See Also

Reports
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View a report

Save a report to a file

Create a new report

Edit a report

My Reports

Save a report to a file

Save a report to a file

A report can be saved as an .htm file, which can be viewed in a web browser or in Microsoft Excel, among
other programs. To do this, select the report of interest and click Save to file.

The user will be able to enter any required prompts information, and then will need to specify where the file
should be saved and what it should be called

See Also

Reports

View a report

Email a report

Create a new report

Edit a report
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My Reports

Create a new report

Create a new report

To create a new report from scratch, click New.

This will open the Report wizard in a new window. This wizard provides a drag-and-drop interface that
allows the user to specify the layout and behavior of their new report.
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The process of creating the report involves dragging gage characteristics from the list in the bottom left
corner to the appropriate places on either the print preview to the right or the boxes to the top.

The area on the right side of the window is a print preview. This is what the first page of the report would
look like if it were printed right now. Columns can be added, moved, or removed by dragging them to the
desired spot on the preview form or the trash can icon.

The four boxes in the top left area of the wizard can be used to control the look and behavior of the report
file.
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Prompts – If a gage characteristic is added to this box, this report will ask the user to specify what values a
gage must have for that characteristic in order for the gage to be included on the report.

Ordering – This box refers to the sort order of the list. The gages in the report will be ordered in ascending
or descending order by whatever characteristic(s) is/are dropped into this box.

Group – The report will be broken into sections based on the gage characteristic that is added to this box.
For example, if ‘Gage typeʼ is put into this box, there will be a section in the report for calipers, and another
section for micrometers, and so on.

Where – This box works much the same way as the filters on the inventory grid. By dropping a gage
characteristic into this box, the user will be able to specify what values a gage must have for the specified
characteristic in order to be included in the report.

The screen shot below shows a report that, when run, will prompt the user to specify a location. Once the
user has done so, the report will show a list of all active gages due for calibration within the next 6 months.
The list will be broken up into sections by gage type and each individual section will be sorted by calibration
due date.
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Once the layout and design of the report is finished, click Save and provide a name when prompted. Once
finished, the new report will appear on the standard list of reports. To find user-created reports quickly,
select ‘USERʼ from the category dropdown list at the top of the form.

See Also
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View a report

Email a report

Save a report to a file

Edit a report

My Reports

Edit a report

Edit a report

To modify an existing report, select it from the list and click Edit.
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If the report was originally created with the report design wizard, it will be editable using the same wizard
(discussed in the next section). If not, the report file will be opened in the default text editor.
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Report files use a combination of standard SQL and a special report syntax designed by PQ Systems. The
report syntax is explained in detail in a document included with every installation of GAGEpack. By default,
this document is located here:

C:\Program Files (x86)\PQ Systems\GAGEpack 13.0\Documents\GAGEpack Reporting Scheme120.doc

See Also

Reports

View a report

Email a report

Save a report to a file

Create a new report

My Reports

My Reports

My Reports

My Reports allows each user to create a small collection of their own commonly used reports. To access
this list, click My Reports.
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The complete list of reports will be replaced with the list of the userʼs previously selected reports.
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To add or remove reports from this list, click Manage.
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View a report

Email a report

Save a report to a file

Create a new report

Edit a report

Views

Views

Views enable users to quickly apply a previously saved configuration of columns and settings to the main
form tabs.

To create a view, click the Snapshot button on the ribbon bar.
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Give the view a name and click OK to save it.

To apply a previously saved view to the inventory, click Views from the ribbon bar.

Select the desired view and click Apply.

See Also

Gage management

Gage form

Adding a gage

Editing a gage

Deleting a gage
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Copying a gage

Cloning a gage

Finding a specific gage

Search and replace

Filters

Reports

Upcoming gage events

Upcoming gage events
This chapter covers the various ways to see what events are scheduled to be completed soon. Many of these
topics are covered in other places in this document, but here we will discuss utilizing these features
specifically for the purpose of knowing what events are coming due.

In this chapter

Color-coding

Sorting

Filters

Reports

Calendar

To do list

GAGEmail

Color-coding

Color-coding

There are three color-coding statuses available to signal that a gage is past due for some event. They are
"Past due for calibration," "Past due for maintenance," and "Past due for R&R." If color-coding is enabled,
any gages that fall into one of these three categories will be highlighted using the color associated with their
status.

It is recommended that users not rely heavily on this method for two reasons.

#1 – Gages that are colored are already PAST due, which means the opportunity to complete the event on
time has already come and gone. The event is late if the gage is colored.

#2 – It is not practical to scroll through the gage list looking for colors.

Color-coding late events is meant to be a warning flag that something has gone wrong, not a way to
schedule activity.

Please see Configuring GAGEpack for information about setting up color-coding.

See Also
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Upcoming gage events

Sorting

Filters

Reports

Calendar

To do list

GAGEmail

Sorting

Sorting

Sorting the gage inventory list by one of the three due-date columns represents a quick and easy way to see
the event schedule. Simply add a due-date column to the inventory grid and sort it by clicking on the column
header. Adding columns and sorting are both covered in the Inventory tab section of Getting Started.

See Also
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Filters

Filters

Filters can be created in such a way that, when applied to the inventory grid, they will show only gages that
are coming due for a certain event within a certain window of time. For instructions on how to create a filter,
please see Gage management. The section Time-frame filters contains an example of this type of filter.

See Also
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Reports
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Reports

There are about 20 different "Due for " reports included in GAGEpack by default. These can be viewed from
the reports list accessible from the inventory tab toolbar. In addition, custom reports can be created by the
user to display the desired information about upcoming events. For information about viewing, editing,
creating, and sharing reports, please see Gage management.

See Also
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GAGEmail

Calendar

Calendar

The calendar can be accessed from the default inventory tab toolbar. It offers an overview of the event
schedule in either daily, weekly, or monthly view. It can also record and display user-created alarms and
notes, which can be created using the calendar toolbar.
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In daily and weekly views, the gage events will be displayed as hyperlinks. These can be clicked on to launch
the associated event directly from the calendar view.

See Also
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GAGEmail

To do list

To do list

The To do list is the main feature of the Tasks tab. It displays a list of all of the events that are scheduled to
take place within a user-defined window of time. This list is always up to date in that it will immediately
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reflect relevant changes made elsewhere in the software.

In This Section

To do list control panel

To do list columns

Printing the to do list

Emailing the to do list

To do list worksheets

Gages due based on uses

See Also
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To do list control panel

To do list control panel

The control panel at the top of the To do list allows the user to specify what should appear on the list. The
check boxes can be used to activate and deactivate the display of calibration events, R&R studies,
maintenance activities, and expiring vendor certifications.

Show items for allows the user to define the date range of interest for the list. The dropdown list has a
series of pre-defined ranges in addition to the options of looking ahead by N days and simply selecting the
end date from a calendar.
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See Also
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Printing the to do list

Emailing the to do list

To do list worksheets
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Emailing the to do list

Emailing the to do list

Once GAGEpack has been configured to send emails (see chapter 4), the To do list can send messages
concerning its content. To access the email mechanism, click Email in the ribbon bar.
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There are two options for recipients of emails. The most basic is to send the complete To do list to a single
recipient by selecting The individual e-mail receiver defined below and typing in an email address.

The other option is to select The individual gage E-mail to. This option refers to the EmailTo field found
on the general tab of the gage viewing form. If it is selected, every email contact in the database with a
gage that currently appears on the To do list will receive a personalized message that will show a list of only
their gages.

The message itself will contain a .htm file attachment, which can be opened in any web browser. This
attachment will display the gage information using the same columns that appeared on the To do list at the
time the message was sent.
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To do list worksheets

To do list worksheets

It is possible to use the To do list to generate a collection of worksheets for all of the calibration and
maintenance events that are currently displayed on the list. Simply click Worksheets in the ribbon bar. No
extra input is required.

See Also
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Gages due based on uses

Gages due based on uses

The To do list handles gages due based on the number of uses by estimating their due dates and then
displaying them along with gages that have actual due dates. Estimated due dates are highlighted to set
them apart from actual due dates.

These dates are estimated by assuming that the rate of uses-consumption is constant between calibrations.
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For example, if a gage was calibrated 10 days ago and at the present time 20 percent of its uses have been
consumed, its due date will be estimated to be 40 days from today.

See Also
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Printing the to do list
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To do list worksheets

GAGEmail

GAGEmail

GAGEmail is an add-on program designed to work in conjunction with GAGEpack. It is a Windows Service
application, which means it will run automatically and silently in the background whenever the computer is
turned on and it does not require any input from the user.

GAGEmail is designed to monitor a gage database for upcoming gage events and generate email alerts to be
sent to the people who are responsible for completing the events.

For information about how to install GAGEmail, please see the document located here:

C:\Program Files (x86)\PQ Systems\GAGEpack 13.0\Documents\Getting started with GAGEmail.docx

For information about how to configure GAGEmail activity in a particular database, please see GAGEmail
settings in Configuring GAGEpack.
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Recording gage events
This chapter explains the process of adding gage events to the database. It also explains features and
functions unique to each of the gage event types.

The process of adding an event to GAGEpack almost always involves three steps. They can be loosely
described as follows:

1. Launch the event form.

2. Fill out the event form.

3. Click OK to save.

Step 3 is simple enough not to warrant discussion. Step 2 will vary depending on which event is being
completed. The variances are described in the event sections throughout this chapter. Step 1 is covered in
the first section.

In this chapter

Launching gage events

Calibration

External Calibration

Check-out

Check-in

Maintenance

Verification

Repair

Other

Multi-gage events

Group events

R&R variables study

R&R attribute study

R&R stability study

R&R linearity study
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R&R uncertainty study/bias

Launching gage events

Launching gage events

There are several ways to initiate the process of adding a gage event to the database. Not every event type
can be launched using every method described in this section, but here we cover all the methods. Itʼs
important to note that all of these methods will have the same effect. These options simply represent
multiple ways of doing the same thing (launching a gage event form). The method to use is a matter of
personal preference.

In This Section

Inventory tab toolbar

Gage history tab

Calendar hyperlink

To do list

Right-click selection menu
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R&R uncertainty study/bias

Ribbon bar

Ribbon bar

To launch an event using this option, click on the gage of interest so that it is highlighted and then click on
the appropriate icon on the ribbon.
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Gage history tab
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To do list

Right-click selection menu

Gage history tab

Gage history tab

The history tab of the gage viewing from has a dropdown at the bottom labeled Add new event. Selecting an
event type from this dropdown will launch an event of that type for the currently selected gage.
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Calendar hyperlink

To do list

Right-click selection menu

Calendar hyperlink

Calendar hyperlink

When the calendar is open in either daily or weekly view, the scheduled events are displayed as hyperlinks
rather than plain text. Clicking on these links will launch the associated event.

See Also

Launching gage events
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Gage history tab

To do list

Right-click selection menu

To do list
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To do list

Double-clicking on any row of the To do list on the tasks tab will launch the event associated with that row.

See Also

Launching gage events

Inventory tab toolbar

Gage history tab

Calendar hyperlink

Right-click selection menu

Right-click selection menu

Right-click selection menu

A gage can be "selected" on the inventory tab by clicking on it. If at least one gage is selected in this way,
right-clicking on the gages grid will display a menu that includes events that can be launched from here.

See Also

Launching gage events
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Calibration

Calibration

The calibration event form allows the user to view, edit, and input information about the event and the gage,
and also record the measurements that were taken before and after any adjustment to the gage. This
section explains the meaning and purpose of the available fields and buttons on the form.

In This Section

General

Calibration results

Actions
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Other

Multi-gage events

Group events

R&R variables study

R&R attribute study

R&R stability study

R&R linearity study

R&R uncertainty study/bias

General

General

Information about the event

Entered by – The name of the person who is adding this event to the database.

Done by – The name of the person who performed the calibration.

Date – The date when this calibration was performed.
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Next date – The date of the next calibration. This can be adjusted from this field if necessary.

Certificate number – The next available certificate number. This number will be applied to this event.

Temperature/Humidity – Used to record the temperature and humidity in the calibration environment.
These fields will be filled out automatically if there is a THUM device plugged into the computer.

Cost/Time (hours) – Used to record how much the calibration cost and how long it took to complete.

UserField1/UserField2 – Blank fields which can be renamed to allow the user to record more information on
the general form.

Calibration vendor – The dropdown contains a list of all of the vendors stored in the database. Used to
specify which vendor performed this calibration, if not completed internally.

Purchase order number- – Used to store the purchase order number associated with this calibration event,
if there is one.

Certificate (file) – This field can be used to link an external file to this event.

Notes – A place to make any additional comments about this event.

Information about the gage

Condition of the gage – This dropdown is used to specify the state of the gage during the calibration.

Status – This field is used to update the status of the gage. When the calibration event is saved, the gage
status will be updated so that it matches the value of this field.

Location – This field is used to update the current location of the gage. When the calibration event is saved,
the gage location will be updated so that it matches the value of this field.

Active – This checkbox is used to update the active/inactive status of the gage. When the calibration event is
saved, the gage active/inactive status will be updated so that it matches the state of this checkbox.

Other features of the form

Event name (optional) – This is a text field that can be used to offer a brief summary of the contents of this
event. This field is visible as one of the columns on both the global and gage-level history tabs.

Adjustment made – This is a label that simply shows whether or not the values in the ‘Result after adjʼ
column of the calibration results tab are different from the values in the ‘Result as foundʼ column.

File – If there is a calibration procedure file linked to this gage on the ‘Calibrationʼ tab of the gage viewing
form, this button will open that file.

Procedure – This button will display the contents of the calibration procedure text box that appears on the
‘Calibrationʼ tab of the gage viewing form.

Print gage label after saving event – If this box is checked, GAGEpack will automatically generate a system
calibration label once the event has been saved to the database.

Print certificate after saving event - If this box is checked, GAGEpack will automatically generate a
calibration certificate once the event has been saved to the database.

Load form from last like event for this gage – Pushing this button will fill out the contents of the general
form so they exactly match the last calibration entered for this gage.

Read temperature and humidity from THUM – This button will re-fetch and update the values from the
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THUM device, if there is one plugged in to the computer.

Overall result – This field must be completed before the event can be saved. Every calibration event must
be labeled as ‘Passʼ or ‘Fail.ʼ

See Also

Calibration

Calibration results

Actions

Calibration results

Calibration results

The table at the bottom of the 'General' tab is used to record the measurements taken during the calibration.
The grid here is created based on the contents of the ‘Calibration stepsʼ tab of the gage viewing form.

Grid columns

Name – Comes directly from the calibration steps grid on the gage viewing form. Identifies the step on each
row. This column is not editable here.

Is atr? – Short for "Is this an attribute step?" This is used to distinguish between variables and attribute
steps. This column is not editable here.

Target – Shows the ideal value for this step.

Units – Units of measurement (inches, millimeters, pounds, volts, etc). This column is not editable here.

Result as found – Shows what the gage was reading at the start of the calibration.

Result after adj – Shows what the gage was reading after any adjustments have been made.

P/F as found – This column is filled out automatically once Result as found is populated. It evaluates the
value entered in that column against the Max and Min values for the current step and flags the step as
either ‘Passʼ or ‘Fail.ʼ

P/F after adj - This column is filled out automatically once Result after adj is populated. It evaluates the
value entered in that column against the Max and Min values for the current step and flags the step as
either ‘Passʼ or ‘Fail.ʼ
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Max – The maximum acceptable value for this step.

Min – The minimum acceptable value for this step.

Master gage – This is a dropdown list that contains all of the active master gages in the database (unless
certain options are enabled to restrict the masters available for selection) . If a master gage was used for
this step, this column can be used to associate that gage with this step.

Comment – Any additional notes about the step can be added here.

Uncertainty – This column is only visible if the associated checkbox is enabled under Setup > Preferences >
Global settings > General. It is used to store the uncertainty value for this step.

Other features of the tab

Show previous data – This button will display a grid of every historical calibration event recorded for this
gage. Each row on the grid will show the results of those calibration events.

Chart previous data – This button will display the data shown using Show previous data in graphical form.

Coding active. Increment= - This label will be visible only if the increment value for this gage has been
defined on the ‘Calibration stepsʼ tab of the gage viewing form. If the label is visible, pushing Page Up or
Page Down on the keyboard while the cursor is in one of the result columns of the grid will fill that cell with
the target value for that row. The value can be increased or decreased by one increment by pushing Page
Up or Page Down, respectively.

After pressing Enter move – This button is a toggle that controls how the cursor moves within the
calibration results grid after pushing Enter on the keyboard.

See Also

Calibration

General

Actions

Actions

Actions

This tab will be visible only if the associated check box is enabled under File > Settings > Global settings
> Validation criteria. If enabled, and if a gage is found to be out of calibration or fails to calibrate correctly,
the user will not be able to save the event without providing details of any shippable product that might have
been affected by the inaccurate gage and explain any corrective action that has been taken in response to
the failure.

See Also
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Check-out

What it means for a gage to be "checked-out" has been intentionally left vague. Checking a gage out and
back in can mean whatever the organization wants it to mean. The check-out event form provides a location
to store information about the check-out and update a few attributes of the gage.

Event name (optional) – This is a text field that can be used to offer a brief summary of the contents of this
event. This field is visible as one of the columns on both the global and gage-level history tabs.

Checked by – The name of the person who is adding this event to the database.

Used on these jobs – Allows the event and the gage to be associated with one or more of the jobs stored in
the database. These dropdown lists display the contents of the ‘Job Numberʼ choice list which can be viewed
and edited by going to Setup > Preferences > Global collections > Choice lists.

Used on these parts - Allows the event and the gage to be associated with one or more of the parts stored
in the database. These dropdown lists display the contents of the Parts collection which can be viewed and
edited by going to Setup > Parts.

Check Date – The date when this gage was checked out.

Status – This field is used to update the status of the gage. When the event is saved, the gage status will be
updated so that it matches the value of this field.

Location – This field is used to update the current location of the gage. When the event is saved, the gage
location will be updated so that it matches the value of this field.
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Active – This checkbox is used to update the active/inactive status of the gage. When the event is saved, the
gage active/inactive status will be updated so that it matches the state of this checkbox.

Cost/Time (hours) – Used to record how much the event cost and how long it took to complete.

UserField1/UserField2 – Blank fields which can be renamed to allow the user to record more information on
the form.

Document – A reference to any external file.

Notes – A place to make any additional comments about this event.

Load form from last like event for this gage – Pushing this button will fill out the contents of the general
form so they match the last event of this type entered for this gage.

See Also

Recording gage events

Launching gage events

Calibration

External Calibration

Check-in

Maintenance

Verification

Repair

Other

Multi-gage events
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R&R variables study

R&R attribute study
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R&R uncertainty study/bias

Check-in

Check-in

Check-Ins are the opposite of Check-Outs.



GAGEpack

166 / 298

Event name (optional) – This is a text field that can be used to offer a brief summary of the contents of this
event. This field is visible as one of the columns on both the global and gage-level history tabs.

Checked by – The name of the person who is adding this event to the database.

Used on these jobs – Allows the event and the gage to be associated with one or more of the jobs stored in
the database. These dropdown lists display the contents of the ‘Job Numberʼ choice list which can be viewed
and edited by going to Setup > Preferences > Global collections > Choice lists.

Used on these parts - Allows the event and the gage to be associated with one or more of the parts stored
in the database. These dropdown lists display the contents of the Parts collection which can be viewed and
edited by going to Setup > Parts.

Check Date – The date when this gage was checked out.

Uses – Records the numbers of times the gage was used while it was checked out. This is a critically
important field for gages that are calibrated on an interval based on the number of times the gage has been
used.

Status – This field is used to update the status of the gage. When the event is saved, the gage status will be
updated so that it matches the value of this field.

Location – This field is used to update the current location of the gage. When the event is saved, the gage
location will be updated so that it matches the value of this field.

Active – This checkbox is used to update the active/inactive status of the gage. When the event is saved, the
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gage active/inactive status will be updated so that it matches the state of this checkbox.

Cost/Time (hours) – Used to record how much the event cost and how long it took to complete.

UserField1/UserField2 – Blank fields which can be renamed to allow the user to record more information on
the form.

Notes – A place to make any additional comments about this event.

Load form from last like event for this gage – Pushing this button will fill out the contents of the general
form so they match the last event of this type entered for this gage.

See Also
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Maintenance

Maintenance

Maintenance events are used to record routine servicing activity that is not covered during standard
calibrations. These events also used to note the completing of the Preventative Maintenance tasks that are
assigned and scheduled on the ‘PM Tasksʼ tab of the gage viewing form.

In This Section

General

Tasks

See Also

Recording gage events
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Check-out

Check-in
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Verification

Repair

Other

Multi-gage events

Group events

R&R variables study

R&R attribute study

R&R stability study

R&R linearity study

R&R uncertainty study/bias

General

General

Entered by – The name of the person who is adding this event to the database.

Done by – The name of the person who performed this event.

Date – The date when this gage was checked out.
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Next date – The date of the next maintenance. This can be adjusted from this field if necessary.

Condition of the gage – This dropdown is used to specify the state of the gage during the maintenance.

Status – This field is used to update the status of the gage. When the event is saved, the gage status will be
updated so that it matches the value of this field.

Location – This field is used to update the current location of the gage. When the event is saved, the gage
location will be updated so that it matches the value of this field.

Active – This checkbox is used to update the active/inactive status of the gage. When the event is saved, the
gage active/inactive status will be updated so that it matches the state of this checkbox.

Cost/Time (hours) – Used to record how much the event cost and how long it took to complete.

UserField1/UserField2 – Blank fields which can be renamed to allow the user to record more information on
the form.

Document – Used to associate this event with some external file.

Notes – A place to make any additional comments about this event.

See Also

Maintenance

Tasks

Tasks

Tasks
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The tasks tab lists all the preventative maintenance tasks that are supposed to be completed for this gage,
along with their individual due dates. To complete this tab, check the boxes associated with the tasks that
have been completed during this maintenance event.

Other features of the form

Event name (optional) – This is a text field that can be used to offer a brief summary of the contents of this
event. This field is visible as one of the columns on both the global and gage-level history tabs.

File – If there is a calibration procedure file linked to this gage on the ‘Calibrationʼ tab of the gage viewing
form, this button will open that file.

Procedure – This button will display the contents of the calibration procedure text box that appears on the
‘Calibrationʼ tab of the gage viewing form.

Print label after saving event – If this box is checked, GAGEpack will automatically generate a system
calibration label once the event is saved to the database.

Load form from last like event for this gage – Pushing this button will fill out the contents of the general
form so they match the last event of this type entered for this gage.

See Also

Maintenance

General
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Verification

Verification

Verification events are used to confirm that a gage is reading accurately without formally calibrating it.
These events are commonly completed prior to a series of important measurements in order to double-
check that the results will be valid.

In This Section

General

Results data
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Entered by – The name of the person who is adding this event to the database.

Done by – The name of the person who performed the verification.

Date – The date when this calibration was performed.

Temperature/Humidity – Used to record the temperature and humidity in the calibration environment.
These fields will be filled out automatically if there is a THUM device plugged into the computer.

Read temperature and humidity from THUM – This button will re-fetch and update the values from the
THUM device, if there is one plugged in to the computer.

Cost/Time (hours) – Used to record how much the calibration cost and how long it took to complete.

UserField1/UserField2 – Blank fields which can be renamed to allow the user to record more information on
the general form.

Certificate file – This field can be used to link some external file to this event.

Notes – A place to make any additional comments about this event.

Information about the gage

Status – This field is used to update the status of the gage. When the event is saved, the gage status will be
updated so that it matches the value of this field.
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Location – This field is used to update the current location of the gage. When the event is saved, the gage
location will be updated so that it matches the value of this field.

Active – This checkbox is used to update the active/inactive status of the gage. When the event is saved, the
gage active/inactive status will be updated so that it matches the state of this checkbox.

Other features of the form

Event name (optional) – This is a text field that can be used to offer a brief summary of the contents of this
event. This field is visible as one of the columns on both the global and gage-level history tabs.

Load form from last like event for this gage – Pushing this button will fill out the contents of the general
form so they exactly match the last event of this type entered for this gage.

Overall result – This field must be completed before the event can be saved. Every verification event must
be labeled as ‘Passʼ or ‘Fail.ʼ

See Also

Verification

Results data

Results data

Results data

This tab is used to record the measurements taken during the verification event and compare them to the
target values. By default, the grid on this table will be populated using the table on the ‘Calibration stepsʼ tab
of the gage viewing form.
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Grid columns

Name – Comes directly from the calibration steps grid on the gage viewing form. Identifies the step on each
row. This column is not editable here.

Is atr? – Short for "Is this an attribute step?" This is used to distinguish between variables and attribute
steps. This column is not editable here.

Target – Shows the ideal value for this step.

Units – Units of measurement (inches, millimeters, pounds, volts, etc). This column is not editable here.

Result– Shows what the gage reads.

Pass/Fail – This column is filled out automatically once Result has been populated. It evaluates the value
entered in that column against the Max and Min values for the current step and flags the step as either
‘Passʼ or ‘Fail.ʼ

Max – The maximum acceptable value for this step.

Min – The minimum acceptable value for this step.

Master gage – This is a dropdown list that contains all the master gages in the database. If a master gage
was used for this step, this column can be used to associate that gage with this step.

Comment – Any additional notes about the step can be added here.
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Uncertainty – This column is only visible if the associated checkbox is enabled under Setup > Preferences >
Global settings > General. It is used to store the uncertainty value for this step.

Other features of the tab

Coding active. Increment= - This label will be visible only if the increment value for this gage has been
defined on the ‘Calibration stepsʼ tab of the gage viewing form. If the label is visible, pushing Page Up or
Page Down on the keyboard while the cursor is in one of the result columns of the grid will fill that cell with
the target value for that row. The value can be increased or decreased by one increment by pushing Page
Up or Page Down, respectively.

After pressing Enter move – This button is a toggle that controls how the cursor moves within the
calibration results grid after pushing Enter on the keyboard.

Add step – If it is necessary to test the gage at a range not already specified in the default calibration steps
grid, additional rows can be added to the verification table by clicking this button.

Delete step – Push this button to remove the currently selected row from the grid.

Delete all – Removes all of the steps from the grid.

See Also

Verification

General

Repair

Repair

Repair events are used to record a repair.
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Event name (optional) – This is a text field that can be used to offer a brief summary of the contents of this
event. This field is visible as one of the columns on both the global and gage-level history tabs.

Entered by – The name of the person who is adding this event to the database.

Received by – The name of the person who accepts the repaired gage back from whoever repaired it
(optional).

Date – The date when the repair was performed.

Date received – The date of the repaired gage being restored to the active gage inventory.

Purchase order number\- – Used to store the purchase order number associated with this event, if there is
one.

Cost/Time (hours) – Used to record how much the repair cost and how long it took to complete.

Status – This field is used to update the status of the gage. When the event is saved, the gage status will be
updated so that it matches the value of this field.

Location – This field is used to update the current location of the gage. When the event is saved, the gage
location will be updated so that it matches the value of this field.

UserField1/UserField2 – Blank fields that can be renamed to allow the user to record more information on
the general form.
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Vendor – The dropdown contains a list of all of the vendors stored in the database. Used to specify which
vendor performed this repair, if not completed internally.

Vendor contact – The name of the person who represents the vendor that performed the repair event.

Document – This field can be used to link an external file to this event.

Notes – A place to make any additional comments about this event.

Active – This checkbox is used to update the active/inactive status of the gage. When the event is saved, the
gage active/inactive status will be updated so that it matches the state of this checkbox.

Load form from last like event for this gage – Pushing this button will fill out the contents of the general
form so they match the last repair entered for this gage.

See Also
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These events are used to record some happening or add some note to the history of a gage in those cases
where the event does not fall under the category of one of the other event types.
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Event name (optional) – This is a text field that can be used to offer a brief summary of the contents of this
event. This field is visible as one of the columns on both the global and gage-level history tabs.

Entered by – The name of the person who is adding this event to the database.

Date – The date when the event took place.

Uses – Records the numbers of times the gage was used during this event. This is a critically important field
for gages that are calibrated on an interval based on the number of times the gage has been used.

Cost/Time (hours) – Used to record how much the event cost and how long it took to complete.

Status – This field is used to update the status of the gage. When the event is saved, the gage status will be
updated so that it matches the value of this field.

Location – This field is used to update the current location of the gage. When the event is saved, the gage
location will be updated so that it matches the value of this field.

Active – This checkbox is used to update the active/inactive status of the gage. When the event is saved, the
gage active/inactive status will be updated so that it matches the state of this checkbox.

UserField1/UserField2 – Blank fields which can be renamed to allow the user to record more information on
the general form.

Notes – A place to make any additional comments about this event.
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Load form from last like event for this gage – Pushing this button will fill out the contents of the general
form so they match the last repair entered for this gage.

See Also
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Multi-gage events

Multi-gage events

Calibrations, check-outs, check-ins, and ‘Otherʼ events can be completed on a many-gages-at-once basis. To
launch these types of events, select the gages of interest by clicking-and-dragging (or holding Shift or Ctrl
to select multiple gages), and then click the appropriate button on the Events tab of the ribbon bar.

The event form will have most of the same fields that appear on the single-gage version of the event type. 
The main difference is that the multi-gage event will include a tab called Gages which will allow you see the
list of included gages and make changes if necessary. Click OK to save the event to the database.
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Note: Every gage associated with a multi-gage event will have a unique event added to its own history. For
example, a multi-gage calibration with five gages will add five single-gage calibration events to the database,
not one multi-gage calibration.

Note: If necessary, it is possible to open a calibration event that was previously entered using a multi-gage
event and edit it. For example, this is useful for adding calibration results data.

See Also
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R&R variables study

R&R attribute study

R&R stability study

R&R linearity study

R&R uncertainty study/bias

Group events

Group events

Group events are used to record calibration, check-out, and check-in events for every gage in a group at
once. When a group event is launched, the user will be prompted for the name of the group to be serviced.

The form that is displayed will be the same as the one used for multi-gage events. The same notes apply to
group events as well. Please see the associated section above for details.

Note: The list of groups in the database is defined using the ‘Groupʼ choice list which can be accessed by
going to File > Settings > Global collections > Choice lists.

Note: A gage is assigned to a particular group by selecting the group from the associated dropdown list on
the ‘Generalʼ tab of the gage viewing form.
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R&R uncertainty study/bias

R&R variables study

R&R variables study

GAGEpack supports a five-step process for doing R&R studies.

The five steps are:

1. Determine due dates for R&R. This step can be accomplished by selecting R&R studies only on the
Tasks tab, by filtering the gage list, or by running any one of several Due for R&R reports.

2. Print R&R worksheets. This step can be done only at the individual study level. It requires that the
study is set up before the worksheets can be printed.

3. Enter the data into the R&R study. This can be done manually from the keyboard or electronically if
desired. In addition, data in the right format can be pasted directly from the clipboard.

4. Analyze results. The standard percentages are available using the X-Bar and Range method and
ANOVA. In addition, several charts are available on the Charts tab for analyzing the data more
specifically.

5. View/Print reports. This can be done at the individual gage level, and the report will be customized
to the method used to calculate the percentages for Equipment Variation, Appraiser Variation, R&R
Variation, and Part Variation. These percents can be calculated based on Study variation,
Specification, and Process variation. In addition, GAGEpack provides Don Wheelerʼs Honest Gage study
results as well as ANOVA. GAGEpack provides a number of charts for analyzing an individual R&R
study. A number of reports can be done that show an R&R for an individual gage or group of gages
as well as showing multiple R&R events for a single gage.

Users can choose to customize these steps to develop their own unique R&R processes.  

In This Section
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R&R Templates

R&R Templates

R&R templates allow duplication of an R&R study setup for use with subsequent studies. This template saves
the study and process parameters, appraiser names, and part reference values if these existed when the
template created. Save will allow the user to create a new template by naming the current configuration.
Load will allow the user to select a previously saved template as the starting point for a new study. Delete
deletes a previously saved template.

In This Section

Creating a template

Loading a template

Deleting a template

See Also

R&R variables study

Conducting an R&R variables study

R&R study worksheets
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Creating a template

Creating a template

If this is a common R&R study setup, you can save the study and process parameters with names and true
values as a template.

To create a template:

1. Set up the study with the desired information on a new R&R study form, or select a prior study that
has the desired parameters. Any item on the first three tabs can be changed and saved as part of the
template.

2. Click on the Templates button and the R&R study templates screen will open.
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3. Click on the Save button and window will open asking for a name for this template.
o You can create an unlimited number of templates.

See Also

R&R Templates button

Loading a template

Deleting a template

Loading a template

Loading a template

To load a template:

1. From the R&R study form, click on the Templates button.

2. Highlight the template that you want to use.
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3. Click the Load button and the load question will appear.

4. Click on Yes and the template will be loaded.

See Also

R&R Templates button

Creating a template

Deleting a template

Deleting a template

Deleting a template

To delete a template:

From the R&R study form, click on the Templates button.

1. Select the template that you want to delete.

2. Click the Delete button and the delete question window will open.
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3. Click on the Yes button to confirm the deletion.

See Also

R&R Templates button

Creating a template

Loading a template

General tab

General tab

1. Highlight the gage for which you want to record the R&R study. (You can open the gage form as well
by double-clicking on it.)

2. Click on the R&R study icon. (If you opened the gage form you can also go to the History tab on the
gage form and select R&R

Study from the Add new event menu.) The R&R study form will open.
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3. The General tab will be displayed. Enter a name for the R&R study, if desired. This information will
appear in the event name field of the History tab.

4. If you are logged into GAGEpack, your name will appear in the Entered by field. If not, enter your
name in the Entered by field. You can type it in or select it from the user choice list. The same
process can be used to fill the name in the Study done by field.

5. The current date and time are automatically recorded by GAGEpack. In addition, the date for the next
event is shown and can be edited at this time. The Status field shows the current status of the gage.
Likewise, Location shows the current location. You can change any of these by typing over the data.
Location and Status may also be changed through choice lists drop-down menus for these fields.
Record this data for traceability.

6. There are two Event user-defined fields that can be used to record additional information. Choice lists
can be created to facilitate entering this information.

7. Enter Cost for the test and Time (hours) (both optional). If data is consistently entered here, several
summary reports will summarize and display this information.

8. The Active box may be checked or unchecked to reflect the current status of a gage. The default for
an existing event done prior to the introduction of this box is to check the box as Active.

9. A gage label may be printed at the conclusion of the event by checking the box Print label after
saving that will reflect the new due date for a passed calibration event.

10. Enter any other general information that you desire to preserve with the study or want to appear on
the report in the Notes section of the General tab. You may want to put items into the Notes section
after the study has been completed.

See Also
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To enter an R&R study

Study parameters tab

Parameters tab

Parameters tab

A standard study is generally based on the example given in the Measurement Systems Analysis manual
distributed by AIAG. In general, AIAG uses 3 appraisers, 2 replications, and 10 parts in the examples.
Therefore, when the R&R study form appears, the default study parameters are 3 appraisers, 2
replications, and 10 parts. These can be easily changed by typing over the values or by loading a specific
saved template. (See R&R templates menu for more information on loading templates.)

1. Click on the Study parameters tab to enter the Study parameters: number of Appraisers (1 – 20;
normally 1 – 3), number of Replications (1 – 20; normally 2 – 3), and number of Parts (1 – 20;
normally 5 – 10) or select a saved template by clicking on the Template button.

NOTE: To use a template with this R&R study, open the R&R study templates screen by clicking on the
Templates button and selecting a template to load. Once a template has been selected, click Load and the
parameters will be entered into the study. Make any desired changes. For more information on templates,
see R&R Templates button.

2. Change any of the defaults if necessary. For the rest of this discussion, we will use 3 appraisers, 2
replications, and 7 parts.

3. If study results are desired using specifications, the Specifications can be entered now or at some
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later time.

4. If study results are desired based on process parameters (factors coming from a variables control
chart using the same measurement as used in the R&R study), the Process parameters can be
entered now or at some later time.

5. The Data format can be specified primarily to limit the number of digits to display to the right of the
decimal.

6. The Units of measure can be typed in even though it has no effect on the analysis.

7. One of the options that GAGEpack permits is a destructive analysis using units (parts) that are thought
to be more alike for replications than parts (units) selected to represent the range of the process. In
the case of Destructive testing, the analysis of the data can be done only by using ANOVA. To do a
destructive test, check the Treat this study as a destructive (non-replicable) test box on the Study
parameters tab. Once the study data has been entered and the study has been saved, the user can
no longer check or uncheck this box.

8. Once the Study parameters tab has been completed, click on the Names & text tab. Before going to
that tab, we will address templates and worksheets.

NOTE: If there is a desire to use a template, it can be loaded at this time and worksheets printed with the
appropriate information entered. If names are desired and have not been entered, the user must enter them
on the Names & text tab prior to printing the worksheets and reports.

See Also

To enter an R&R study

General tab

Names tab

Names tab

This tab is used to enter appraiser and part names, reference values, study objectives, part designation, and
the measurement characteristic. If the names for the parts and appraisers are entered prior to printing the
worksheet, the names will appear on the worksheet and the RR study data tab.

To enter information on the Names tab:

1. Click on the Names tab to display this form. Move the cursor to the field into which you want to place
a value.
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2. Type the appraiser names and reference values if appropriate (optional).

NOTE: The gage number is fixed as the gage is selected prior to beginning the study.

3. Enter information concerning the part name and/or number in the Part name or number field.

4. Enter information concerning the measured characteristic in the Measured characteristic field.

5. Enter the objective for doing the R&R study in the box labeled Study objective.

NOTE: Any general notes that you need to record for this R&R study may be entered in the Notes section of
the General tab.

6. Click on the Study data tab to enter data when it is available.

See Also

Printing an R&R study worksheet

Study data tab

Data tab

Data tab

Click on the R&R Study data tab to display the data entry form shown below. Use this form to record the
study data manually, using direct entry from an electronic device or pasting from the clipboard. The data
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fields on this form are based on the settings that you specified on the Study parameters tab.

To manually enter study data:

1. Enter the first replication for Alvin (the first appraiser) for all parts used in the study.

2. Enter the next replication for the first appraiser for all parts used in the study.

3. Repeat step 2 above until all replications for Alvin (Appraiser 1) have been entered.

4. Repeat steps 1 through 3 for Simon and Teddy (the remaining appraisers) used in the study

5. When the data has been completely entered, click the OK button to save the study or click on one of
the tabs to the left of the Study data tab and then click on the Study data tab showing the statistics
have been calculated. Now, click on the Study results tab to begin analyzing the results.
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In This Section

Copying and pasting input

See Also

Printing an R&R study worksheet

Names and text tab

Copying and pasting input

Copying and pasting input

R&R study data can be pasted into a study from the clipboard, and data in a study may be copied to the
clipboard.

To paste data "ONLY" to the Study data grid:

1. Copy the data for an R&R study to the clipboard. The data can be in a data management file (such as
Excel or Access) or in a text file. The data needs to conform to the pattern shown above (the part
replications in a column with each appraiser's measurements grouped together.

2. Select the gage that was used to gather the data.

3. Create or open a previously created R&R study without data.

4. Click on the Study data tab and the data grid will be displayed.

5. Right-click on the data grid opening the paste/copy window.

6. Select Paste data from clipboard and the data will be pasted into the grid.
o The user needs to ensure that the data is in the same format as the data grid on the Study

data tab.
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o This pastes everything on the Clipboard to the grid, starting with the field for the first part and
first appraiser.

NOTE: Any missing or peripheral information will result in an error message and can result in an incorrect
pasting of the data to the study grid.

To copy data to the clipboard:

1. Open a previously created R&R study with data, or create a study and fill in the data grid.

2. Click on the Study data tab.

3. Right-click on the study data grid and select Copy data to clipboard (data only).

4. Select OK and the window will close.

See Also

Study data tab

R&R study worksheets

R&R study worksheets

Since an R&R study can be uniquely defined each time it is run, worksheets can be printed only after the
study has been defined. Generally, a gage will only have one R&R study defined, and it may be repeated on
some periodic basis. It is possible to have more than one R&R study defined for a gage that is used for
different measurements for the same or different customers requiring an R&R to be done for different
measurements.

NOTE: If you want the appraiser names and other information printed on the worksheet, the information will
need to be filled in on the Names & text tab.

In This Section

Printing an R&R study worksheet

See Also

R&R variables study

Conducting an R&R variables study

R&R Templates button

Study results tab

Charts tab

Printing an R&R study worksheet

Printing an R&R study worksheet

To print a worksheet for a defined study from the Study parameters tab:

1. Click on the Preview menu.
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2. Select Worksheet (random) or Worksheet (sequential). Each individual replication, appraiser and
part will be listed either randomly (for the experimental design) or sequentially, for the ease of data
entry on one or more printed sheets.

3. Click on the Printer icon to print the worksheet.

In This Section

Names and text tab

Study data tab

See Also

R&R study worksheets

Results tab

Results tab

In This Section

Calculating statistics and study results

Editing an R&R event record

See Also

R&R variables study

Conducting an R&R variables study

R&R Templates button

R&R study worksheets

Charts tab
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Calculating statistics and study results

Calculating statistics and study results

To compute the results of the R&R study:

1. Click on the Study results tab to display this form and click on Compute.

2. In the Compute results based on field, select the option that you want GAGEpack to use for
calculating R&R percentages. Options are:

Study parameters This option uses the settings specified in the Study parameters tab
and the data entered in the study. The ranges for the replicated
measurements and the means of the appraisers' total measurements
are used to determine estimates of the standard deviations for
Equipment Variation (EV) and Appraiser Variation (AV). The
averages of the part measurements are used to estimate the
standard deviation of the Process Variation (PV). The percentages
are determined by dividing each component by the Total Variation
(TV). This is the default option.

Specifications This option uses the spread of the specifications to calculate R&R
percentages. This option is available only if the specification data has
been entered on the Study parameters tab. The percentages for this
option are determined by dividing the specification range by six (to
represent the specification range as one standard deviation). This in
turn is used in the place of TV to calculate the percentages for EV,
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AV, R&R and PV.

Process parameters This option uses the process parameters to determine the estimate
of total variation, and uses that total variation to calculate R&R
percentages. This option is available only if process parameter data
has been entered on the Study parameters tab.

EMP III This option uses the settings specified on the Study parameters tab
and the data entered in the study. The parts used in the study are
used to estimate process variation. The formulas and statistics come
from the "Honest gage study" as defined by Don Wheeler in a paper
titled "An Honest Gauge R&R Study" (March 2008).

o  The statistics calculated as follows:

Statistic Representing Formulas

EV Equipment variation

AV Appraiser variation

PV Part variation

R&R Repeatability & Reproducibility

TV Total variation

EV% Equipment variation percentage

AV% Appraiser variation percentage

PV% Part variation percentage

RR% R&R percentage

o  K1 values are based on the number of trials. For 2 trials, this is estimated at 0.8862. For 3
trials, this is estimated at 0.5908.

o  K2 values are based on the number of appraisers. For 2 appraisers, this is estimated at 0.707.
For 3 appraisers, this is estimated at 0.5231

o  K3 values are based on the number of parts. These are estimated as follows:

Number Parts K3 value

2 0.7071

3 0.5231

4 0.4467
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5 0.4030

6 0.3742

7 0.3534

8 0.3375

9 0.3249

10 0.3146

o For more precise K1, K2, and K3 values, refer to the AIAG Measurement Systems Analysis,
Third Edition.

o Intermediate stats, used in creating charts for this study are also shown. These are , ,
R(p), UCL(r), LCL(r).

3. If you select Specifications, Process parameters or EMP III, the data in the results fields will clear.
Click on the Compute button and GAGEpack will calculate the values for the option selected. If the
options for Specifications and/or Process parameters are grayed out, you will need to enter
specifications or process parameter values on the Study parameters tab.

See Also

Study results tab

Editing an R&R event record

Editing an R&R event record

Editing an R&R event record

To edit an R&R event record from a previously entered R&R study:

1. From the Gage list, double-click on the gage for which the R&R event was recorded to open the
Gage form.
o You can also use the Find function to locate the gage and the Edit gage icon to open the

Gage viewing form.

2. Click on the History tab.

3. Select the R&R event you want to edit.

4. Click on the Edit event button to open the R&R study form.

5. When you are finished making changes, click the OK button.

See Also

Study results tab

Calculating statistics and study results

Charts tab

Charts tab
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In This Section

R&R - Charts and Analysis

See Also

R&R variables study

Conducting an R&R variables study

R&R Templates button

R&R study worksheets

Study results tab

R&R - Charts and Analysis

R&R - Charts and Analysis

In This Section

To display an R&R chart

Creating R&R charts

Editing R&R charts

Editing R&R charts

Chart Descriptions

See Also

Charts tab

To display an R&R chart

To display an R&R chart

To display an R&R chart:

1. Click on the Charts tab of the R&R study form if this is not already the current tab.

2. Highlight the name of the chart you want to see and click on the Draw button.

3. To close the chart, click on the X in the upper right corner of the chart window or press the Esc key.

If you need help interpreting the charts, the AIAG Measurement Systems Analysis manual (available at
www.aiag.org) and Dr. Donald Wheelerʼs Evaluating the Measurement Process (available from
www.spcpress.com) are useful references.

See Also

R&R - Charts and Analysis

Creating R&R charts

Editing R&R charts

Editing R&R charts

Chart Descriptions

Creating R&R charts

Creating R&R charts

To create R&R charts:

http://www.aiag.org
http://www.spcpress.com
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1. Click on the Charts tab of the R&R study form.

2. Click the Add button to display the R&R chart form.

o Default charts are included with the program as a reference for defining charts.

3. Enter a name for this chart in the Chart name field.
o This field is required. The default name is "New name".
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4. Enter a description of the chart in the Description field. This field is optional.

5. Select OK to close the screen.

See Also

R&R - Charts and Analysis

To display an R&R chart

Editing R&R charts

Editing R&R charts

Chart Descriptions

Editing R&R charts

Editing R&R charts

To edit an existing chart or default chart:

1. Click on the Charts tab of the R&R Study form if this is not already the current tab.

2. Select a chart to edit by highlighting it.

3. Click the Edit button.

4. Make desired changes.

5. Click the OK button

See Also

R&R - Charts and Analysis

To display an R&R chart

Creating R&R charts

Editing R&R charts

Chart Descriptions

Editing R&R charts

Editing R&R charts

To edit an existing chart or default chart:

1. Click on the Charts tab of the R&R study form if this is not already the current tab.

2. Highlight the chart you desire to modify its appearance.

3. Click the Draw button or double-click on the chart name.

4. Right-click on the chart that you desire to take action on, and the action window will open.
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5. Highlight the action you desire to take.

6. Follow the indicated steps to completion of the desired action.

7. Click the OK button.

See Also

R&R - Charts and Analysis

To display an R&R chart

Creating R&R charts

Editing R&R charts

Chart Descriptions

Chart Descriptions

Chart Descriptions

In This Section

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias

R&R intraclass correlation plot

R&R multi-chart

R&R ANOVA

See Also

R&R - Charts and Analysis

To display an R&R chart

Creating R&R charts

Editing R&R charts

Editing R&R charts



GAGEpack

202 / 298

R&R X-bar and range charts

R&R X-bar and range charts

This chart is the combination of the Part Appraiser Average chart and Repeatability Range chart. On the X-
bar chart, at least half of the points should fall outside the control limits. On the Range chart, all of the points
should fall within control limits.

To display multiple sets of control limits on the chart, exclude out-of-control Range subgroups, or add titles:

1. Right-click on the chart.

2. Select any of the options available if desired.

3. Add, modify, and/or delete titles.

4. Click the Close button.

See Also

Chart Descriptions

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias
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R&R intraclass correlation plot

R&R multi-chart

R&R ANOVA
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R&R Part appraiser average chart (X-bar)

R&R Part appraiser average chart (X-bar)

This X-bar chart shows the part averages for each appraiser. The averages on this chart represent part and
measurement variation. The chart provides a check on the operator-to-operator consistency and relative
measures of the usefulness of the measurements. The pattern of part averages should be the same across
operators. If the measurement system is able to determine the differences in the parts, more than half the
points will fall outside the limits.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias

R&R intraclass correlation plot

R&R multi-chart

R&R ANOVA
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R&R repeatability range chart (Range)

R&R repeatability range chart (Range)

This chart plots the range for each subgroup and shows the consistency of the differences in the
measurements each operator has made on each chart. Each range represents multiple measurements of the
same part for the same characteristic using the same gage by the same operator. If all ranges displayed on
this chart are in control, the appraisersʼ variation in measurements is essentially the same. If an appraiserʼs
range falls outside the control limits, this appraiser may be using a measurement method that differs from
that used by the other appraisers, or there may be another special cause. If most appraisers have ranges
outside the control limits, the measurement system is too sensitive to the measurement methods to be
useful. In either case, ranges outside the limits are to be excluded from the analysis or replaced once the
cause has been determined.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias

R&R intraclass correlation plot

R&R multi-chart
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R&R ANOVA
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R&R appraiser average run chart

R&R appraiser average run chart

Also called an Interaction Plot, this chart displays the part average for each part by appraiser in a run chart.
The difference between this and the X-bar chart is that this is a multi-line chart, where each appraiser is
super imposed over the others on the scale. It helps in determining the consistency among appraisers and
the usability of the measurement system by comparing the results of the average readings by part for each
operator graphically. If the part averages differ by a substantial amount, and appraiser lines cross, some
appraiser-part interaction may have taken place. If one appraiserʼs averages fall above or below the other
appraisers', it may indicate appraiser bias.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias

R&R intraclass correlation plot

R&R multi-chart

R&R ANOVA
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R&R accuracy/deviation whiskers chart

R&R accuracy/deviation whiskers chart

This chart shows the high and low data values and the averages by part and by appraiser. This illustrates
the deviation of the measured values from the average values. The large I represents the range deviation
made by an appraiser on one part. This helps determine measurement consistency by an appraiser, and
across appraisers, and shows abnormal readings and part appraiser interaction.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias

R&R intraclass correlation plot

R&R multi-chart

R&R ANOVA
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R&R gage error histogram

R&R gage error histogram

Also called Accuracy/Deviation Histogram, this chart shows the distribution of the deviations from the
average of the part values or from the reference values if they are included. Ideally, the values will be
centered on 0.0 with a bell-shaped curve. The tighter the base of the bell, the smaller the variation is about
the average (or reference) values.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias

R&R intraclass correlation plot

R&R multi-chart

R&R ANOVA
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R&R gage performance curve

R&R gage performance curve

Use the Gage performance curve chart to determine the probability of either accepting or rejecting a part
with a particular measurement value. The left axis represents the probability of acceptance, from 0 to 1. For
a part value that lies on one of the specification limits, the probability of acceptance would be 0.5, if the
measurement is unbiased.

To select study or process parameters to overlay the process curve, use reference values and/or add titles:

1. Right-click on the chart.

2. Select Edit chart from the pop-up menu.

3. Select any of the options available if desired.

4. Add, modify, and/or delete titles.

5. Click the Close button.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R appraiser inconsistency
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R&R appraiser bias

R&R intraclass correlation plot

R&R multi-chart

R&R ANOVA
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R&R appraiser inconsistency

R&R appraiser inconsistency

The Appraiser Inconsistency chart is a control chart of average ranges by each appraiser. It shows whether
there is a detectable difference among the ranges of part measurements for each appraiser. Analysis for
appraiser inconsistency can be performed if more than one appraiser is used in the study. Inconsistency is a
way of seeing if the range for one appraiser is statistically different from the others. This analysis is similar
to that of the range chart in the X-bar and Range charts. The data should fall inside control limits. If an
appraiserʼs average range falls above the upper control limit, that appraiserʼs replications are statistically
farther apart than the replications made by the other appraisers.

To add titles:

1. Right-click on the chart.

2. Select Edit chart from the pop-up menu.

3. Add, modify, and/or delete titles.

4. Click the OK button.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram
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R&R gage performance curve

R&R appraiser bias

R&R intraclass correlation plot

R&R multi-chart

R&R ANOVA
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R&R appraiser bias

R&R appraiser bias

The Appraiser Bias chart is an X-bar chart of the averages of all the measurements made by an appraiser.
By plotting averages of all the measurements taken by each appraiser on a control chart, one can see
statistically if one of the appraisers is measuring the parts in a way that is biased (higher or lower) from the
others. All the appraisersʼ averages should fall within the control limits. If any appraiserʼs average
measurement is above the upper control limit, that appraiser is measuring the parts statistically larger than
the other appraisers. If any appraiserʼs average measurement is below the lower control limit, that appraiser
is measuring the parts statistically smaller than the other appraisers.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R intraclass correlation plot

R&R multi-chart

R&R ANOVA
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R&R intraclass correlation plot

R&R intraclass correlation plot

The Intraclass Correlation Plot is a plot of ranges of measurements made by a gage. It illustrates the
relationships between total variation and measurement error. The major axis (long line) represents the total
variation attributable to product variation and measurement error. The minor axis (short line) is attributable
to the measurement error alone. The Discrimination Ratio (D.R.) compares the total variation to the
measurement variation. A Discrimination Ratio greater than four is considered acceptable. As the D.R. gets
larger, the Intraclass Correlation Plot becomes more elliptical and less round. The Intraclass Correlation
Coefficient (ICC) measures the same thing as the D.R., but is limited to a scale of 0.0 to 1.0. The ICC should
be greater than 0.8824. The D.R. should be greater than 4.0. These calculations are made based on the
assumption that the appraiser variation is zero. The long axis of the ellipsoid represents the total variation
(part variation plus equipment variation) and the short axis represents the equipment variation.

Right-click on the chart window and select Edit chart to specify if category squares should be drawn on the
Intraclass Correlation Plot to display the D.R. in squares. A D.R. = 4 implies that four squares will be drawn.
You can add chart titles through this form also.

To select Draw category squares and/or to add titles:

1. Right-click on the chart.

2. Select Edit chart from the pop-up menu.

3. Select or de-select category squares.

4. Add, modify, and/or delete titles.

5. Click the OK button.

See Also

Chart Descriptions
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R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias

R&R multi-chart

R&R ANOVA
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R&R multi-chart

R&R multi-chart

The Multi-chart lets you select up to six charts to be viewed or printed on one page. Click on the Add button,
give the chart a name, and select the charts to be included from the list of available charts by clicking on the
check box next to the chart name. The only charts available to be included are those that have been defined
for this study.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias

R&R intraclass correlation plot

R&R ANOVA
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R&R ANOVA

R&R ANOVA

Ideally, the sum of the squares (SS) for the appraiser and appraiser part interaction should not be
significant. If the associated p-value is smaller than the desired alpha value (usually 0.05 or 0.01), then the
source of variation is considered to be significant. In addition, the column following the F value will display an
asterisk if the source of variation is significant.

Calculating the "percent of total" here is similar to calculating the percent of total variation under the R&R
study results. The "% Contrib" (percent contribution) calculates the percent of the total variation contributed
by the factor listed (e.g., appraisers) based on the variances (SS). Since variances are additive, the "%
Contrib" will sum to 100 percent.

To view a standard ANOVA table for the study:

1. From the Gage list, double-click on the gage for which the R&R event was recorded in order to open
the Gage viewing form. You can also use the Find function to locate the gage and the Edit gage
icon to open the Gage viewing form.

2. Click the History tab. Then, locate the R&R event for which you want to see the ANOVA table.

3. Click the Edit event button to open the R&R study form.

4. Click the ANOVA tab. Use the drop-down menu to set an Alpha for F-tests values.

5. Generally, for experimental investigative purposes the alpha value is set at a relatively high value
(0.10) when compared to the alpha value normally used in quality control (0.0027). In this case the P-
value becomes useful, since it is indicating that the values are significant beyond the 0.001 level.

6. The factors Appraiser, Parts and Appraiser x Part (interaction) are all significant, indicated by the
asterisk in the column next to the F column. The parts should be significant, since the objective is to
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be able to distinguish among the parts. However, you do not want either Appraisers or the
Appraiser/Part interaction to be significant.

7. This part of the analysis provides a calculation of the R&R percentages (% of Total column) using the
ANOVA sum of squares analysis to determine the percentages. They should be similar but not exactly
equal to those obtained using the traditional analysis. In addition, the ANOVA approach typically
provides another column of percentages (% Contribution). These percentages are figured using the
variances, and the R&R percentage plus the Part-to-part percentage will add up to 100 percent.

See Also

Chart Descriptions

R&R X-bar and range charts

R&R Part appraiser average chart (X-bar)

R&R repeatability range chart (Range)

R&R appraiser average run chart

R&R accuracy/deviation whiskers chart

R&R gage error histogram

R&R gage performance curve

R&R appraiser inconsistency

R&R appraiser bias

R&R intraclass correlation plot

R&R multi-chart
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R&R attribute study

R&R attribute study

To conduct an Attributes R&R study:

1. Open the Attributes study form.
o Move the highlight to the record for the gage that you want.  Click the Attributes R&R study

icon.
o Double-click on the record to open the Gage viewing form. Click on the gage History tab.

Select Attributes Study from the Add new event drop-down menu.

In This Section

General study setup tab

Study names tab

Study data tab

Cross tabs tab

Study results tab

See Also

Recording gage events

Launching gage events

Calibration

External Calibration

Check-out

Check-in

Maintenance
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Verification

Repair

Other

Multi-gage events

Group events

R&R variables study

R&R stability study

R&R linearity study

R&R uncertainty study/bias

General study setup tab

General study setup tab

1. The General study setup tab will be displayed. Enter a name for the Attributes Study, if desired. This
information will appear in the Event name field of the History tab.

2. Enter your user name in the Entered by field. You can type it in or select from the user choice list. If
user login is activated when you start GAGEpack, your name will appear in the Entered by field. If
you do not use login, the default entry is Supervisor.

3. Date and time are automatically recorded in the study Date field. To change the date, click on the
down arrow on the right side of the field. A calendarform will open. Click the right or left arrows to
change the month. Click on a date to select it.

4. Next date is a new field added to this screen and allows the user to reset the next due date at the
entry of the current study information.

5. The study Done by field allows you to enter the name of the operator who conducted the study.

6. Enter cost to accomplish the study and the time in hours required into the Cost and Time (hours)
fields if you desire to track these items.

7. The Status field shows the current status of the gage. Likewise, Location shows the current location.
You can change any of these by typing over the data. Location and Status may also be changed
through choice lists drop-down menus for these fields. Record Status and Location at the time of the
study for traceability purposes.

8. Enter a number of Appraisers, Parts, and Replications in their respective fields. (3 appraisers, 50
parts with 3 replications are the suggested numbers.)

9. Use the optional Notes field to enter any notes about the study.

See Also

R&R attribute study

Study names tab

Study data tab

Cross tabs tab

Study results tab

Setup tab
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Setup tab

1. To enter the names of the appraisers', click the Setup tab. Enter the appraisers' names.

See Also

R&R attribute study

General study setup tab

Study data tab

Cross tabs tab

Study results tab

Data tab

Data tab

1. To enter the test results, click the Data tab. When you first click on the tab, the form shows all ones.
If a part is considered to be good (passes), enter a 1 in the field. If the part fails, leave a zero (0) in
the field. If a part passes for all appraisers, click on the green smiley face to set that part to all ones.
If a part fails for all appraisers, click on the Red face to set all zeros. The current default is to all
passes.
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2. Each of the test results has the default set to good (1). If there is a reference for each part (1 is good
and 0 is bad), make sure it is entered correctly. Using the faces to change the new to all passes or all
fails does the same to the reference. The references are used in the analysis, but their numerical
equivalence recorded under Ref. value is not used in the analysis.

3. Enter the reference values if known for each part. These are numerical values and not pass/fail.
These values do not enter directly into the analysis, but can be used to determine the reference
(pass/fail) if specifications are known.

See Also

R&R attribute study

General study setup tab

Study names tab

Cross tabs tab

Study results tab

Cross tabs tab

Cross tabs tab

1. If you are using AIAGʼs Cross Tab Method for Hypothesis Test Analysis, click the Cross tabs tab to
view these results. The first set of cross tabs will be between appraisers and the second with each
appraiser and the Reference. If the references are not known, the second set of cross tabs and
resulting Kappa values are all irrelevant.
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See Also

R&R attribute study

General study setup tab

Study names tab

Study data tab

Study results tab

Results tab

Results tab

1. For the study results, click the Results tab. The Kappa values indicate the level of agreement
between two appraisers or between one appraiser and the reference. Guidelines are:
o K> 0.75 good to excellent agreement

o 0.40 < K< 0.75 acceptable agreement

o K< 0.40 unacceptable agreement

o K=0 implies random agreement
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2. Click the Report button to view or print a report of the Attributes study.

To better understand the results, consult a measurement systems analysis reference such as that published
by the Automotive Industry Action Group, Measurement Systems Analysis Fourth Edition.

See Also

R&R attribute study

General study setup tab

Study names tab

Study data tab

Cross tabs tab

R&R stability study

R&R stability study

Process stability refers to the ability to predict what is to come. When a process is stable, it is subject only to
common cause variation. Without process stability, the statistics for repeatability and reproducibility, cannot
help you predict future outcomes.

In terms of measuring equipment, stability is the total variation in the measurements obtained with a
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measurement device on the same unit (frequently called a master) when measuring a single characteristic
over an extended period of time. In this instance, stability refers to the predictability of the equipment over
time.

The appropriate time interval is often a major consideration when analyzing the measurement system.
Knowledge of the circumstances and conditions in which the equipment is used will help identify special
causes when the system is unstable. Action should be taken to make the measurement system robust to the
conditions that cause instability.

The more likely it is that the system will change, the shorter the time interval should be between samples.

In This Section

Entering an R&R stability study

Editing a continuing R&R stability study

Deleting an R&R stability study

See Also

Recording gage events

Launching gage events

Calibration

External Calibration

Check-out

Check-in

Maintenance

Verification

Repair

Other

Multi-gage events

Group events

R&R variables study

R&R attribute study

R&R linearity study

R&R uncertainty study/bias

Entering an R&R stability study

Entering an R&R stability study

In This Section

To setup a stability study for a gage

See Also

R&R stability study

Editing a continuing R&R stability study

Deleting an R&R stability study

To setup a stability study for a gage

To setup a stability study for a gage

1. Open the Stability study form. To do this:
o On the Inventory tab, highlight the gage that you want to add to the stability study. Click on
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the Stability study icon.
o On the Inventory tab double-click on the record to open the Gage viewing form. Click on the

History tab. Select Stability Study from the Add new event drop-down menu.

2. Enter a Study name and Master part name in the respective fields.

3. Enter the number of Replications for this study.
o Once you click on the Add entry button, you cannot change the number of replications. The

information entered in the Study name field will be displayed in the gage history list.

4. Click on the Add entry button to enter data.
o The current date will be added automatically, but can be edited.

5. If user login is not activated, the default entry for Entered by is Supervisor. Different information can
be entered in place of supervisor or selected from the pull-down menu if desired. If user login is
activated, the current user name will be listed in the Entered by field.

6. Enter the data collected into the sample.
o You might consider taking 5 to 10 samples initially to establish some preliminary limits for the

control chart.  

7. Once sufficient data has been collected, click the Draw chart button to see the control chart and to
check for out-of-control conditions.

8. Click the OK button.
o Since data is entered into a stability study periodically (once each hour, once per day, etc.),

the study must be edited to enter new data as it is collected.  When entering the History tab,
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click on the study and edit it, or if the Stability study icon is clicked on, a pop up window will
ask whether you want to continue with the most recent stability study (if one exists) or create
a new one. In addition, the data for the stability event advances to the date of the most
recently entered data keeping it more current on the History tab.

See Also

Entering an R&R stability study

Editing a continuing R&R stability study

Editing a continuing R&R stability study

On some periodic basis, additional samples are to be entered using the same part, gage, appraiser, method,
etc. After the sample has been entered, the chart can be drawn and checked for out-of-control conditions.

In This Section

To edit an R&R study

See Also

R&R stability study

Entering an R&R stability study

Deleting an R&R stability study

To edit an R&R study

To edit an R&R study

1. Gather the data as outlined above.

2. Select the gage on the gage list.  

NOTE: An option here is to select the Stability study icon which asks if you want to open the most current
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stability study found. If you want any other study opened, you will need to follow the steps below.

3. Open the gage for editing on the History tab.

4. Find the Stability study on the history list and open it for editing.

5. Enter the sample data.

6. Select Draw chart and check for out-of-control conditions. One point out will be denoted as a red box.
A run of seven points above or below the mean will be indicated by six consecutive points with unfilled
red boxes, with the seventh and any continuing points designated by filled red boxes.

7. Take appropriate action:

a. If the process is in control, close the chart, click OK, and schedule the next sample to be
taken.

b. If the process is out of control, look for assignable causes and take appropriate action. If
appropriate after the action has been taken, schedule the next sample.

8. Repeat steps 1 to 7.

NOTE: As a sample is entered, the date for the stability study will become current, placing it based on the
date of the most recent data. Data should be entered into a Stability Study periodically—for example, once
each day, once per hour, etc. If the process remains stable for long periods of time, consider lengthening the
calibration period. The process is stable if all the points lie within the control limits. An out-of-control point
on the range chart indicates excessive variation within a sample larger than one or between samples of size
one. An out-of-control point on the X-bar chart or X chart indicates a change in the measurement center. If a
point falls outside the control limits or if there is a run of 7 points above or below the mean, look for
assignable causes and take corrective action (such as calibration, appraiser training).

See Also

Editing a continuing R&R stability study

Deleting an R&R stability study

Deleting an R&R stability study

To delete an R&R stability study:

1. Click on the History tab and move the highlight to the Stability study that you want to delete.

2. Right-click on the history and select Delete event from the pop-up menu.
o You will be prompted to confirm the deletion.  

3. Click the Yes button.

4. Click the OK button.

See Also

R&R stability study

Entering an R&R stability study

Editing a continuing R&R stability study

R&R linearity study

R&R linearity study
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This option allows you to define a linearity study for a gage. Linearity describes how bias varies over the
operating range of the gage. For a 6" micrometer, you might analyze readings at 0.5", 1", 3", 4", and 5.5".
You can use parts or standards, such as gage blocks, but you must have an acceptable reference value for
each item measured. To estimate the bias for a specific reference, take the average of all measurements for
that specific part and subtract the reference value. For that reference part, no bias would mean a zero
value. Repeat this for all the parts used in the study. A straight line is fit to the bias values for each of the
reference parts using least squares regression. The coefficient of determination (r2) indicates how much of
the variation of the points around a horizontal line is explained (by size of the part) by the regression
equation. Ninety-five percent confidence limits are developed around the regression line. If a horizontal line
drawn at 0.0 on the vertical axis is contained completely with the confidence limits over the operating range
of the gage, then the gage can be said to have a zero bias over its operating range. A second test checks the
average bias at each of the selected values to see if these values also fall within the confidence limits. If so,
the gage can be said to have a zero bias throughout its operating range. If a gage fails the test, corrective
action (such as calibration, repair, or replacement) should be taken.

In This Section

Entering a linearity study data for a gage

Editing an R&R linearity study

Deleting an R&R linearity study
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Entering a linearity study data for a gage

Entering a linearity study data for a gage

To enter linearity study data for a gage:

1. Open the Linearity study form. To do this:
o On the Inventory tab, highlight the gage to which you want to add the Linearity study. Click on

the Linearity study icon.
o On the Inventory tab, double-click on the Gage form. Click on the History tab. Select

Linearity Study from the Add new event drop-down menu and the Linearity study form will
open.



GAGEpack

231 / 298

2. Enter a name for the study in the Event name field. Information entered in this field will appear in
the gage history display.

3. Enter the name of the person who conducted the Linearity study in the Entered by field. This can be
typed in or selected from the user choice list. If user login is activated, the current user will be
entered in the Entered by field. If user logins are not activated, the default entry is Supervisor.

4. The current date is added automatically by GAGEpack. To edit the date, click on the down arrow on
the right side of the field. A calendar form will open. Click on the right or left arrows to change the
month. Click on a date to select it.

5. Enter the number of replications for the study in the Replications field. GAGEpack will create a table
with a column for parts with this many replications in it. Once this value has been filled in, the Study
data tab will become available.

6. The Status field shows the current status of the gage. Likewise, Location shows the current location.
Edit these by typing over the data or selecting a new location or status through choice lists. Record
this data for traceability.

7. Optional fields for recording Cost and Time (hours) are available, as well as two event user fields
that may be named and data entered.

8. Enter the part name, reference value, and replication data in the fields provided.

9. Once the desired information has been entered on the General tab, click on the Study data tab and
the data entry screen will open.
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10. Enter the part names and reference values in the top two rows of the data grid. These may be some
type of gage block or different parts with known measurement values throughout the range of the
gage (similar to the steps in a calibration).

11. Enter the data into the grid. Data may be entered individually or copied from the clipboard by right-
clicking on the grid and selecting Paste from clipboard.

12. To calculate statistics for Slope, t-slope, R-squared, Intercept, and t-intercept, click on the
Compute button.
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13. To view a report, click on the Report button.

14. To view a linearity plot, click on the Draw chart button. If the Draw chart button is grayed out, click
on the OK button to save the report and then re-open the chart and click on the Draw chart button.
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R&R linearity study

Editing an R&R linearity study

Deleting an R&R linearity study

Editing an R&R linearity study

Editing an R&R linearity study

From the Gage list, double-click on the gage for which you want to edit the Linearity study. You can also use
the Find function to locate the gage and the Edit gage icon to open the Gage viewing form.

To edit an R&R linearity study:

1. Click the History tab and select the Linearity study that you want to edit.

2. Click the Edit event button or double-click the event that you want to edit.
o The study will be displayed.

3. Make any desired changes or add additional entries.

4. Click the OK button to close the study.

See Also

R&R linearity study

Entering a linearity study data for a gage

Deleting an R&R linearity study

Deleting an R&R linearity study



GAGEpack

235 / 298

Deleting an R&R linearity study

From the Gage list, double-click on the gage for which you want to delete the linearity study. You can also
use the Find function to locate the gage and the Edit gage icon to open the Gage viewing form.

To delete an R&R linearity study:

1. Click the History tab and select the Linearity study that you want to delete.

2. Click the Delete event button.
o You will be prompted to confirm the deletion.  

3. Click the Yes button.

4. Click the OK button.

See Also

R&R linearity study

Entering a linearity study data for a gage

Editing an R&R linearity study

R&R uncertainty study/bias

R&R uncertainty study/bias

The objective of an uncertainty study is to put bounds on a measurement (plus/minus some interval).
Uncertainty normally gives a 95 percent confidence interval for containing the true value of the
measurement. Generally a 95 percent confidence interval and the t-distribution are used, since there few
observations have been taken. A study normally consists of repeated measurements (GAGEpack allows
sample sizes as large as 100) using one gage, one part, one part characteristic, and one appraiser. The
standard deviation is calculated using the data and the range method for sample sizes up to and including 20
if the Range button has been selected. For sample sizes larger than 20 and up to 100, standard deviation is
based on the squared deviations formula. This method is available for sample sizes less than 20 and can be
selected by checking the Individuals button. Both of the estimates will be shown for samples up to 20. The
uncertainty estimate is obtained by using the selected estimate for the standard deviation and multiplying it
times the appropriate t value. It is displayed as Uncertainty +.

Bias indicates a measurement consistently over or under the true (reference) value for the part. If you want
a bias estimate using the uncertainty data, and you have reference value for the part characteristic used,
enter the reference value in the Reference field on the General tab. GAGEpack will determine the mean of
the measurements and subtract the reference value to calculate an average bias value. GAGEpack also
calculates a t-statistic to determine if the bias is significantly different from zero. If the bias is significant, it
would indicate that some response is required.

There is an option in GAGEpack to calculate bias as a percent of the specification range. If the user enters
the upper specification in the USL field and the lower specification in the LSL field on the General tab, the
Bias (% of specs) will be calculated. If the specs were entered after the data was entered and the Compute
button on the Data tab selected, it will be necessary to select Compute a second time.

In some cases, there may be a significant bias (significantly different from zero), but a relatively insignificant
amount compared to the overall specification range. Once the reference value and the specification limits
have been entered, GAGEpack will calculate the bias as a percentage of the specification range. If one
selects Bias as a % of specs, enters a Max Bias % on the study Data tab and clicks on the Compute button,
GAGEpack will do the rest. For example, if the bias is 3.5 percent and the Max bias is 5 percent, one could
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conclude that no further action is needed. To enter an uncertainty or bias study:

1. Open the Uncertainty-Bias study form. To do this:
o On the Inventory tab, highlight the gage desired to add an Uncertainty/Bias study to. Click on

the Uncertainty-Bias study icon.
o On the Inventory tab, double-click on the Gage desired to add an Uncertainty/Bias study to.

Click on the History tab. Select Uncertainty Study from the Add new event drop-down
menu.

2. The Gage number will be displayed automatically in the Gage field and cannot be changed. If your
organization uses a different term for an uncertainty study, enter it in the optional Event name field.
Data entered in this field will appear in the gage history display.

3. From the drop-down menu in the Done by field, select the name of the person who conducted the
study or type it in. If user login has been activated, the user name will appear in the Done by field. If
user login is not activated, the default entry is Supervisor.

4. GAGEpack automatically adds the current date. To edit the date, click on the down arrow on the right
side of the field. A Calendar form will open. Click the right or left arrows to change the month. Click
on a date to select it.

5. The Status field shows the current status of the gage. Location shows the current location. Edit
these by typing over the data or selecting a new location or status through choice lists. Record this
data for traceability.

Optional fields for recording Cost and Time (hours) are available. Type data into these fields. In addition,
two user-defined event fields are available for use.

6. Select the Data tab.
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7. Enter the gage readings (repetitions) into the Data column and click the Compute button.

8. You have done all the steps required to complete an uncertainty study. If you desire a report, click on
the Report down arrow.

9. Select Uncertainty and the report will be created.

10. Print or save the Report if desired, by clicking on the appropriate icon.

11. Including Bias on an uncertainty study requires only the addition of a reference value for the
measurement being taken. We will add specifications as well.
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12. Select the Data tab and click on the Compute button.
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13. A bias can be significant (not zero) and still not be large enough to change the outcome. If the bias is
small compared to the range of the specifications, it can still can declared relatively insignificant.

14. Return to the Data tab, check the Bias as % of specs box under Acceptance, enter the Max bias
(%) and click on the Compute button. This will result in one of two outcomes: Bias exceeds
acceptable value or Bias is acceptable for continued use.
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15. After clicking on the Compute button, it is obvious that the bias is large enough to make the gage
unacceptable for use in measuring this dimension with this specification.

16. Let's see what happens if we change the Max bias % to 10% and click on the Compute button again.
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17. Now even though the bias is significant, since it is less than 5 percent, the gage can be used to make
this measurement. Since we have added bias to our study, we can look at either a Bias report or a
Both (uncertainty and bias) report. Click on the pull-down menu for Report and select Both.

18. Print or save the report if desired, by clicking on the appropriate icon.

19. Save the study with any changes you have made by clicking on OK.

In This Section

Editing an R&R uncertainty study

Deleting an R&R uncertainty study
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R&R variables study

R&R attribute study

R&R stability study

R&R linearity study

Editing an R&R uncertainty study

Editing an R&R uncertainty study

From the Gage list, double-click on the gage for which you want to edit the uncertainty study. You can also
use the Find function to locate the gage and the Edit gage icon to open the Gage viewing form.

To edit an R&R uncertainty study:

1. Click the History tab. Select the Uncertainty study that you want to edit.

2. Click the Edit event button or double-click the event that you want to edit.
o The study will be displayed.

3. Make any desired changes or add additional entries.

4. Click the OK button to close the study.

See Also

R&R uncertainty study/bias

Deleting an R&R uncertainty study

Deleting an R&R uncertainty study

Deleting an R&R uncertainty study

From the Gage list, double-click on the gage for which you want to edit the uncertainty study. You can also
use the Find function to locate the gage and the Edit gage icon to open the Gage viewing form.

To delete an R&R uncertainty study:

1. Click on the History tab and select the uncertainty study that you want to delete.

2. Click on the Delete event button.
o You will be prompted to confirm the deletion.  

3. Click the Yes button.

4. Click the OK button.

See Also

R&R uncertainty study/bias

Editing an R&R uncertainty study

Utilities
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Utilities
This chapter will examine the collection of miscellaneous utilities that can be accessed from various places
within the software.

In this chapter

Import data

Export data

Import gages

Import events

Import choice lists

Import GAGEpack objects

Export remote calibrations

Import remote calibrations

Import external calibrations

Restore from backup

Labels

My reports

Batch reports

Management statistics

Wear-trend analysis

Information

Custom query

Refresh due dates

Delete event history

Load choice lists from gages

Replace master gage

Master gage circular references

Import data

Import data

This utility is designed to read the contents of a comma or TAB delimited text file that contains gage
information and then import that information into the currently open GAGEpack database. This utility can be
found by going to Utilities > Import > Gages from .csv.

The utility is organized in a wizard format with three pages. The first page requires the user to browse to
the file to be imported and offers a few options to govern the behavior of the import.
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Import file – Use the browse button to navigate to the text file that contains the gage information.

File format – Specify whether the columns in the text file are separated by commas or TAB characters.

How should I treat duplicate gage numbers? – All gage numbers in GAGEpack must be unique. In the
event that the file being imported contains two gages with identical numbers, the wizard will either ignore all
but the first instance of the gage, ignore all but the last instance of the gage (replace the old with the new),
or keep both instances of it while slightly modifying the gage number to preserve the uniqueness, depending
on how this option is configured.

Load – Used to apply a previously saved stored import procedure.

View – Once the ‘Import fileʼ field has been filled out, this button will open the file in Windows.

Cancel – Close the wizard and abandon the import.

Next >> - Proceed to the second step of the import wizard.

The second step requires the user to match up the columns in the text file with the gage characteristics used
in GAGEpack. This is done by selecting the appropriate gage characteristic from the dropdown list in the
green bar at the top of each column.
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Reset – Return all of the green cells to their original blank state.

Previous – Go back to the first screen.

Cancel – Close the wizard and abandon the import.

Next >> - Proceed to the third step of the import wizard.

On the third and final form, the user will push Import to begin the import. The error log will report any
problems, and the ‘Records read,ʼ ‘Records imported,ʼ and ‘Progressʼ labels will keep the user informed
about the current state of the import. Click Close to return to the main screen.
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Save – Store the settings of this import for use later.

Previous – Go back to the second screen.

Cancel – Close the wizard and abandon the import.

See Also
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Refresh due dates

Delete event history

Load choice lists from gages

Replace master gage

Master gage circular references

Export data

Export data

This utility will create a comma delimited text file (.csv) that contains the raw gage information stored in the
GAGEpack database. It can be found by going to Tasks > Utilities > Export data.

Output file – Used to specify the name of the file that is to be created by the export and where the file
should be saved.

Output column names in first row – By default, the first row of the new .csv file will label the column with
the name of the gage characteristic. This can be disabled by unchecking this box.

Convert True/False data to -1/0 – Many of the gage characteristics are stored as Booleans. Use this
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checkbox to specify whether those values should be displayed as ‘TRUE/FALSEʼ or ‘-1/0ʼ

Save – Remember the settings of this export for quick use later.

Load – Restore the settings of a previously saved export.

Clear – Uncheck all of the boxes on the list of the currently active tab.

Export – Once all settings are in place, push this button to launch the process.

Close – Exit the wizard.

In This Section

Gage data

History

See Also

Utilities
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Import gages

Import events
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Replace master gage

Master gage circular references

Gage data

Gage data

This tab contains a list of every gage characteristic in the database. Only those characteristics that are
checked will be included in the export.

The filter dropdown contains the same collection of filters that is available on the inventory grid. If a filter is
activated here, only the gages that match the criteria specified by the filter will be included in the data
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export.

See Also

Export data

History

History

History

This tab contains a list of every event characteristic that is shared by all of the event types. Only those
characteristics that are checked will be included in the export.

The output sequence dropdown allows the user to specify how the content of the export file will be
organized. It can be sorted by gage number or by event date.

See Also

Export data

Gage data

Import gages

Import gages

This utility enables users to transfer gages and their history from one GAGEpack database to another one. It
can be accessed by going to Utilities > Import > Gages from DB.
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First, use the GAGEpack database to import from field to browse to the location of the database file
where the gages to import are currently saved. Once the database has been selected, the Select gages to
import list will be populated with every single gage that exists in the other database.

Use the All or None buttons to check or uncheck all of the gages on the list quickly, or pick gages manually
one at a time.

Push Import to complete the transfer. Copies of the gages, along with their complete histories, will be
written into the current database.

See Also
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Labels

My reports

Batch reports

Management statistics

Wear-trend analysis

Information

Custom query

Refresh due dates

Delete event history

Load choice lists from gages

Replace master gage

Master gage circular references

Import events

Import events

This utility is designed to read the contents of a comma or TAB delimited text file that contains gage history
information and then import that information into the currently open GAGEpack database. The text file must
have a column that contains the gage number that the event belongs to, and those gage numbers must
correspond to gages in the current database. This utility is typically run after the ‘Import dataʼ feature is used
to import a set of gages from some previous calibration software.

This utility can be found by going to Utilities > Import > Events.

First, use the Import file field to browse to the text file containing the gage history information. Use the File
format box to specify whether the columns in the file are separated with commas or TAB characters. Click
Next>> to continue.
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The second page of the wizard requires the user to identify which columns in the text file contain the gage
number and the date of the event. This is done by dragging ‘Gage numberʼ and ‘Event dateʼ from the list on
the left into the green bar at the top of the grid. In addition, comment and gage event columns can be
identified.

If no column is marked as the event type, every event will be imported as a calibration. If the file contains
non-calibration events, the user must use the grid in the top right corner to define how each event type is
identified in the data file. Click Next >> to complete the import.

See Also
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Wear-trend analysis

Information

Custom query

Refresh due dates

Delete event history

Load choice lists from gages

Replace master gage

Master gage circular references

Import choice lists

Import choice lists

Older versions of GAGEpack (v8.5 and prior) stored the contents of the choice lists in a separate database
file. As of v9.0, these lists are stored in the same database as the gage information. This utility exists to give
users the opportunity to import the contents of an old choice list database.

Note – In most cases, importing choice lists is unnecessary. The utility ‘Load choice lists from gagesʼ can be
used to create new choice lists based on the contents of gages already in the database.

First, use the Choice list database field to browse to the .mdb file that contains the choice lists. Once it has
been selected, the Select the choice list to import list will be populated with the set of all choice lists that
exist in that database.

Check the boxes associated with the lists that should be added to the current database and then click Import
to complete the process.

See Also
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Utilities
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Import GAGEpack objects

Import GAGEpack objects

This utility allows users to copy certain GAGEpack collections from one GAGEpack database to another. The
objects available to copy include filters, users, vendors, choice lists, parts, queries, views, email addresses,
PM tasks, and devices.
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First, use the browse button at the top of the form to navigate to the database that contains the objects to
copy. Once it has been selected, use the What to import dropdown to specify which collection should be
copied into the currently active database. Click Import to complete the process.

See Also

Utilities

Import data

Export data

Import gages

Import events

Import choice lists

Export remote calibrations

Import remote calibrations

Import external calibrations

Restore from backup

Labels

My reports

Batch reports

Management statistics

Wear-trend analysis

Information



GAGEpack

256 / 298

Custom query
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Export remote calibrations

Export remote calibrations

This utility is intended to work in conjunction with GAGEpack Remote, which allows users to complete
calibration events from computers that do not have GAGEpack installed. Gage and calibration data are
exported to a ‘Calibration Transfer Fileʼ (.ctf) which is then opened by GAGEpack Remote on the other
computer. The calibration results data are entered into the .ctf using GAGEpack Remote, and then the
contents of the .ctf file are uploaded back into the GAGEpack database, where all records are updated
appropriately.

This utility exists to create the .ctf file that contains the calibration data. Users select a filter from the
dropdown list or manipulate specific selection criteria to define which gages should be included in the export.
All gages that match the defined criteria will have their calibration information saved in the .ctf file.

The File to export field is used to define where the new file should be saved and what it should be called.
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Import remote calibrations

Import remote calibrations

This utility is intended to work in conjunction with GAGEpack Remote, which allows users to complete
calibration events from computers that do not have GAGEpack installed. Gage and calibration data are
exported to a ‘Calibration Transfer Fileʼ (.ctf) which is then opened by GAGEpack Remote on the other
computer. The calibration results data are entered into the .ctf using GAGEpack Remote, and then the
contents of the .ctf file are uploaded back into the GAGEpack database, where all records are updated
appropriately.
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This utility exists to collect the calibration data that has been added to a .ctf file by GAGEpack Remote and
add/update all necessary records in the gage database. Simply browse to the .ctf file using the File to
import field, and then click Import to complete the process.
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Load choice lists from gages
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Import external calibrations

Import external calibrations

GAGEpack has the ability to import external calibration events from files supplied by a calibration vendor and
this section describes the system in detail.

The vendor must supply a text file in comma-delimited format with (eventually) one gage record per line.
Since different vendors may output different fields GAGEpack uses a configuration file – known as a ‘profileʼ –
to filter the contents of the vendorʼs file and to distribute the contents to the relevant fields in the database.

To access the import function: Tasks -> Utilities -> Import external calibrations, which causes the following
form to appear:

To import the information, complete the form then click the Start button. The five entry fields are now
described:

File to import - This section MUST be completed by clicking the browse button [ ] and then locating the
calibration file supplied by the vendor.

Calibration Import Profile - This is also mandatory. A profile is a text file with a .cip extension that
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conforms to the specification set out later in this document. Locate the required .cip file by clicking the
browse button [ ].

Set locations to - This is the same field as ‘Locationʼ that appears on all events. Leaving the box empty will
leave the location of the gage unchanged; otherwise it will be "moved" to the location entered here.

Set status on Pass to  - This and the following field are equivalent to ‘Statusʼ that also appears on every
event form in GAGEpack. Depending on whether a gage passes or fails the calibration, its status will be set
accordingly. Leaving the field blank causes no change in the status.

 and on Fail to - see above description.

Copy the vendor name to ‘Entered byʼ - GAGEpack will attempt to record the vendor name from the file
provided it matches a name already present in the database. In addition, checking this box will cause the
name to be written to the ‘Entered byʼ field of the calibration. If it is not checked, the name of the current
user is placed there.

The import file will vary between calibration labs (and possibly within a lab, depending on what is being
calibrated and who the GAGEpack customer is) but a typical format may be like this:

This file comprises a header, then a set of lines in comma-separated format each of which represents one
calibration, and will be imported into GAGEpack as a new event. Any file in this format may be imported.

To import this and other like files from the same vendor will require a profile (.cip) file located in the
GAGEpack or SysData folder. This is a text file that can be created in Notepad and a suitable profile to import
the above may look like this:

There are two sections: [General] and [Fields] each with a number of lines of the format property=value.
The property settings are:
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Type – currently unused but describes what the file is.

Name – this is the text that will appear in the drop-down list on the import form.

DateFormat – currently only recognises ‘dd/mm/yyyyʼ and ‘mm/dd/yyyyʼ

StartRow – the line where the calibrations start (numbering from 1).

EventName – if present, the name assigned to each of the imported events.

IntervalUnits – required only where the gage calibration interval is to be amended by the import process.
GAGEpack recognises intervals measured in Days, Weeks, Months and Years and the value for IntervalUnits
is a string of 4 pipe-delimited items showing how these intervals are described in the import file. For
example, IntervalUnits=DAYS|WEEKS|MONTHS|YEARS implies that these words will appear in the
appropriate section in the calibration rows.

YesNo – this entry is required only when the data includes Boolean (Yes or No) values. At the time of
writing, this only applies to the Adjusted field described later. The value comprises a pair of values
separated by a pipe, with the first representing ‘Yesʼ

In the Fields sections the rows must start from 1 and contain one entry for each of the items delimited by
commas in the data section of the file. As soon as the sequence is broken, GAGEpack will stop reading the
field values. The item before the pipe (‘| ʼ) is unused (but must be present) and is the ‘localʼ name of the
field; the item to the right of the pipe is the equivalent GAGEpack field. In the example above, Acme Inc
refers to the objects it calibrates by ‘Asset #ʼ and this field is transferred to GAGEpackʼs GageNumber.

In this version, the recognised fields are: GageNumber and EventDate (both madatory) , VendorName,
Result, CertNo, CertFile, Cost, Comment, Adjusted, CalibDueInterval, CalibIntervalUnits, and PoNumber,
together with the user-defined fields: Userfield01 – Userfield10.

The PO Number can appear on each row – that is, can vary from calibration to calibration. If the import file
represents one batch job where each calibration shares a common PO number, then the number need
appear only once somewhere before the data starts. In the first file shown above the line starting with
"PoNumber" followed by one or more spaces followed by some text will be picked up by GAGEpack and the
PO number recorded against each calibration.

Once a profile and input file have been selected, the Start button will be enabled and clicking it starts the
import process. A progress log is displayed in the large box in the lower half of the form and each gage will
either succeed or fail with some error message.

Successfully imported calibrations behave exactly as if they had been entered into GAGEpack manually – they
update the due date (where appropriate), write to the audit trail, cancel alarms, etc.
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Restore from backup

This utility enables users to convert database backup files (.gb? extension) into normal database files (.gpg
extension). Backup files are originally created using either the Backup database command from the
inventory tab toolbar, or the automated backup system configured under Setup > Preferences > Local
settings > Files paths.

To restore a database backup, go to Utilities > Restore. You will be prompted to browse to and select the
backup file. Then you will be prompted for a name and location for the database that will be created. Click
Save to complete the process.
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Labels

Labels

Gage labels can be printed from a number of different locations within the software. There are several
different types of labels available, and all of them are customizable by the user, both in content and format.
This section covers several important topics concerning labels.

In This Section

Label printer

User-defined labels

System labels

Label design wizard
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Label printer

In order to print labels, a label printer must be connected to the computer and setup with Windows.
GAGEpack is compatible with any label printer that is compatible with Windows. Once Windows is aware of
the label printer, GAGEpack can begin using it. Simply go to File > Printers and select the printer from the
list.

It is important to note that the size of the label is determined by the printer, not GAGEpack. To adjust the
label size, go to the Windows ‘Devices and Printersʼ panel and adjust the ‘Printing preferencesʼ of the printer.

See Also

Labels
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Label design wizard

User-defined labels

User-defined labels

Uesr-defined labels are those that are printed from the Labels interface accessible from the Home tab of
the ribbon bar.
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They rely on the user to enter information into a prompts window in order to determine which gages in the
database should have labels generated for them.

New custom labels can be created using the label design wizard, which is explained later in this section.

See Also

Labels

Label printer

System labels

Label design wizard

System labels

System labels

System labels are those that are generated in conjunction with some other feature of the software. For
example, if the Print gage label after saving event box is checked on the Calibration form, a System
Calibration Label will be printed once the calibration has been saved to the database.
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System labels can be printed from calibration, maintenance, and R&R study events. In addition, barcode and
inventory system labels can be printed from the right-click selection menu on the inventory grid.

The content of all system labels can be edited using the label design wizard, explained later in this section.

See Also
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Label design wizard

Label design wizard

The label design wizard is a drag-and-drop interface that can be used to create new user-defined labels,
edit existing user-defined labels that were originally created with the label wizard, and edit system labels. To
access the label design wizard, go to the Print gage labels interface accessible from the default inventory
tab toolbar. To create a new user-defined label, click New. To edit an existing label, select the label and click
Edit. If the label is editable using the label design wizard, the user will be presented with the option to edit
the label using a text editor or the label wizard. Select the label wizard.
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The label design wizard interface is broken up into four sections, explained below.

In This Section

Tools

Conditions

Design

Preview

See Also
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Tools

Tools

The Fields list contains the complete collection of gage characteristics in the database. Any characteristic
can be dragged to the ‘Designʼ area to be added to the label. In addition, there are several Special fields
available to be added. These are fields that are not gage characteristics but are nonetheless commonly
desired for labels.

The bottom of the Tools section contains a trash can where unneeded fields can be dragged from the
‘Designʼ window to be removed from the label.

See Also
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Conditions

Conditions

Prompt for – If a gage characteristic is added to this box, this label will ask the user to specify what values a
gage must have for that characteristic in order for the gage to have a label printed for it.

Order by – This box refers to the order in which the labels will be printed. The gage label printouts will be
ordered in ascending or descending order by whatever characteristic(s) is/are dropped into this box.

Where – This box works much the same way as the filters on the inventory grid. By dropping a gage
characteristic into this box, the user will be able to specify what values a gage must have for the specified
characteristic in order to have a label printed for it.

Note: All three of these boxes will be disabled while editing a system label, since they are not relevant.

Label Type – This field displays the size of the label currently being used. This field is NOT editable and, in
fact, GAGEpack has no control over the size of the label. This value is set by the Printing preferences control
panel in Windows.

Length – The distance (in inches, centimeters, or millimeters) from the left end of the label to the right.

Margin L/R - The distance (in inches, centimeters, or millimeters) from the left and right edges of the label
to the left and right edges of the printable area.

Margin T/B - The distance (in inches, centimeters, or millimeters) from the top and bottom edges of the
label to the top and bottom edges of the printable area.

See Also
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Design

This area contains the grid that controls the layout of the label. Every row on this grid represents a row on
the label. There are five columns that can have an effect on the label.

Font – A number that represents the size of the font for this row.

B – A checkbox that will make this row Bold.

I – A checkbox that will make this row italicized.

Type here – A text field that identifies the contents of the row.

Drag here – Gage characteristics are dragged from the Fields and Special fields lists to this column to be
added to the label.
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See Also
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Preview

This is a simple print preview that displays what the label would look like if it were printed right now. This
preview will be automatically updated as changes are made to the Conditions and Design areas.

Click Save to complete the changes to the label and Close to return to the label list.

See Also
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My reports

This utility allows the user to create a personalized list of commonly-used reports. This gives easy access to
reports they need to see regularly without requiring them to scroll through the long list of reports found on
the main reports list.

My reports can be launched from the Home tab of the ribbon bar. A report on the list can be displayed in
the same way a report is viewed from the standard list.

To add or remove reports from My reports, click Manage My Reports.
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Available reports shows a list of all of the reports accessible to GAGEpack that are not already on the My
Reports list. To edit the contents of My reports, simply drag the reports into the appropriate list. Click OK to
save.

See Also

Utilities

Import data

Export data

Import gages

Import events

Import choice lists

Import GAGEpack objects

Export remote calibrations

Import remote calibrations

Import external calibrations

Restore from backup

Labels

Batch reports

Management statistics

Wear-trend analysis

Information



GAGEpack

271 / 298

Custom query

Refresh due dates

Delete event history

Load choice lists from gages

Replace master gage

Master gage circular references

Batch reports

Batch reports

A batch report is a collection of individual reports that have been clumped together and whose prompt fields
have been pre-populated with values. This grouping exists to enable users to distribute many reports to the
people who need them in a single action. The batch reports button can be added to the inventory tab
toolbar.

In This Section

Creating a batch report

Running a batch report
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Creating a batch report

Creating a batch report

Creating a batch report involves selecting which reports should be included in the batch and filling out any
prompts values required by those reports. To do this, click New from the batch reports list window.

This will open the ‘Batch reportʼ window, which displays a list of all the reports currently included in this
batch report. At first the list will be empty, but reports can be added to the list by clicking Add.

This will display a blank ‘Individual batch reportʼ form. Use Report name to select which report should be
added to the batch. The dropdown list will display every report that GAGEpack is aware of. This is the same
list that appears on the Reports list accessible from the default inventory tab toolbar.

Next, use Destination to define where the report should be sent. This dropdown list will display every email
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recipient that exists in the gage database, as well as the option <Printer> which will simply send the report
to the default GAGEpack printer.

The Description field provides the option to include a line of text about the report. This is visible on the
batch report list.

The Prompts grid at the bottom displays a list of all the prompts that are built into this report. These are the
values the report needs before it can be displayed. However, they can be left blank to instruct GAGEpack to
simply ignore them.

Once all fields are filled out correctly, click OK to save and the report will be added to the batch. Repeat this
process for every report that should be included in the batch.

See Also
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Running a batch report

Running a batch report

To run a batch report, select it from the batch reports list and click Run. Since all of the recipients were
defined and all of the prompts were populated when the batch report was created, no additional steps are
required at this point.



GAGEpack

274 / 298
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Management statistics

Management statistics are similar to reports, in that they are designed to extract information from the gage
database and display it in an easy-to-understand format. The difference is that while reports display
information in plain text, management statistics display information in graphical form.
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These charts can be accessed by clicking on the Charts button on the Home tab of the ribbon bar.

It is possible to create new charts and edit existing charts. For more information, please review the
document called "Management Statistics in GAGEpack 13.0.doc" which, by default, can be found here:

C:\Program Files (x86)\PQ Systems\GAGEpack 13.0\Documents
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Wear-trend analysis

Wear-trend analysis

The wear-trend analysis is designed to predict when a gage will need to be replaced, by examining the
calibration results data for previous calibrations. When one of the gageʼs ranges are seen to be drifting high
or low, a line of best fit is laid over those data points to estimate when the gage will be consistently found to
be inaccurate.
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The wear-trend analysis for a gage can be found by right-clicking on the gage from the inventory tab and
selecting Wear-trend analysis.
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Information

The Information utility provides a few important details about the currently-open database. These include the
database name, the folder where the database is saved, and the number of gages, events, users, and
vendors in the database.

Users can quickly navigate to the database location by clicking the View button to the right of the field.
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Custom query

Custom query

The custom query utility provides those users who are proficient in Structured Query Language (SQL) with
the ability to execute SQL statements against the GAGEpack database.

Note: This can be dangerous. Donʼt tinker with custom queries unless you are confident that you know what
you are doing.
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To create a new query, click Add.

Give the query a name and type the SQL statement into the ‘Query textʼ field. The Show fields button will
display a list of all of the tables in the database. Selecting one of these tables will display a list of all of the
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columns that exist on that table. Click OK to save the query.

To execute a query, click Do query. For SELECT statements, the query results will be displayed in a new
window. Other statements will display a message to inform the user that the statement was executed.
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Refresh due dates

Refresh due dates

This utility will force GAGEpack to recalculate all of the calibration, maintenance, and R&R study due dates
for all of the active gages in the database. In the event that some of the dates have been manually entered
by users, the utility will ask the user if they want to overwrite these dates.

The utility takes into account skip dates, ‘recalculated dailyʼ gages, and ‘end-of-the-monthʼ gages when
calculating the new due dates.

To access this utility, go to Utilities > Refresh due dates.
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Delete event history

This utility will erase all historical records of gage events in the database that occurred before the user-
specified date. To perform this operation, simply select a date from the dropdown calendar and then push
Delete.

GAGEpack will automatically create a backup copy of the database in the specified folder before the history
purge is executed.

This utility can be accessed by going to Utilities > Delete event history.
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Replace master gage

Master gage circular references

Load choice lists from gages

Load choice lists from gages

This utility represents an extremely efficient method for populating the contents of the dropdown lists that
appear throughout the software. It works by creating the lists based on the values that already appear on
the gages in the database.

To perform this operation, select the lists that should be populated (or just click All to select every one of
them), and then click Start. The log box at the bottom of the screen will say "Finished" at the end of the
process.

To access this utility, go to Utilities > Load choice lists.
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Replace master gage

Replace master gage

This utility provides an easy way to update all current references to one master gage with references to a
different one. This is particularly useful in cases where a master gage has been retired or lost or removed
from service for some other reason and is being replaced with a new master gage.

This utility examines all references to master gages on each gage and every calibration step. When it finds
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the ‘Master to replace,ʼ it will remove that gage and replace it with the ‘Replace withʼ gage.

This utility can be found by going to Utilities > Masters > Replace master. The user will also be offered the
opportunity to use this utility whenever they mark a current master gage as inactive or no longer a master
gage.
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Master gage circular references

Master gage circular references

This utility will examine every master gage in the database to check for circular references. A circular
reference occurs when a master is used to calibrate any master in the collection of masters that are used to
calibrate the original gage. For example, if MasterA is used to calibrate MasterB, MasterB is used to calibrate
MasterC, and MasterC is used to calibrate MasterA, a circular reference has occurred.

There is no limit to the size of the circular loop that this utility can detect. No matter how obscure the circular
reference is, it will be discovered by this mechanism.
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To access this utility, go to Utilities > Masters > Circular reference check. To perform the check, simply
click Start.

See Also
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Appendix A: Measurement systems analysis
Variation in the measurement system affects the individual measurement data and subsequently the decision
based upon the data. By identifying the sources of variation, one can make better decisions and improve the
measurement system.

In this chapter

What is a measurement system?

When is it used?

How do you develop a measurement system?

Measurement systems terminology

What is MSA?

What is a measurement system?

What is a measurement system?

A measurement system is the process of quantifying a description of a characteristic of interest. The
resulting number from the process is determined by using a defined unit of measure that is appropriate to
describe the characteristic.

Measurement is used in many different forms. One measures the physical characteristics of an object (e.g.,
"the ball weighs 8 pounds") or the expectations of a person or process (e.g., "I expected him to make more
than one copy" or "the machining should have been 0.005 units smaller"). The appropriate means of
measuring the characteristic depends both on the characteristic and the operational definition of the
measure.

Regardless, the measurement equipment used in the system must be able to detect the variation in a
characteristic of interest. When a measurement system cannot discriminate among the items being
measured, it is said to have inadequate discrimination. Second, the measurement system must be
statistically stable over time. If the system is not stable, one cannot have confidence or trust in the system.
The person viewing the results of the system will be constantly second-guessing the data. Third, any error
due to the measurement system must be small compared to the overall process variation.

See Also

Appendix A: Measurement systems analysis
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When is it used?

How do you develop a measurement system?

Measurement systems terminology

What is MSA?

When is it used?

When is it used?

Whenever it is necessary to do any of the following:

1. To determine the quantity or dimension of a characteristic of interest for a product.

2. To compare one object to another.

3. To quantify the extent to which a process is capable of producing product with the required value for
the characteristics of interest.

See Also

Appendix A: Measurement systems analysis

What is a measurement system?

How do you develop a measurement system?

Measurement systems terminology

What is MSA?

How do you develop a measurement system?

How do you develop a measurement system?

1. Define the standard unit of measure.

a. Choose a unit of measure that permits the quantification of abstraction (e.g., length,
temperature, or mass) into a form capable of being quantified (e.g., yards, degrees
Fahrenheit, or grams).

2. Select the proper instruments.

a. Instruments used in measuring the identified characteristic must meet at least the three
following requirements:
§ They must be calibrated in the proper unit of measure
§ They must be calibrated against a "known standard" which is traceable to a centralized

standard. This centralized standard is usually provided by an organization such as NIST
(National Institute of Standards and Technology)

§ They must be sensitive enough to discriminate adequately among the units being
measured.

b. The discrimination of the equipment must be sensitive enough to identify the within-subgroup
variation.

1. Select the proper method to perform the measurements.
o The method chosen must be appropriate for the task. Guidelines for methods can come from

professional societies, industry standard best practices, or internal sources.
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2. Take the measurements.

3. Record the results.

See Also
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Measurement systems terminology

Measurement systems terminology

In This Section

R&R stability study

Accuracy and precision

Bias

Linearity

Part-to-part variation

Probable error

Repeatability (equipment variation)

Reproducibility (operator variation)

Uncertainty

Remember

See Also
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What is a measurement system?

When is it used?

How do you develop a measurement system?

What is MSA?

R&R stability study

R&R stability study

Process stability refers to the ability to predict what is to come. When a process is stable, it is subject only to
common cause variation. Without process stability, the statistics for repeatability and reproducibility cannot
help you predict future outcomes.

In terms of measuring equipment, stability is the total variation in the measurements obtained with a
measurement device on the same unit (frequently called a master) when measuring a single characteristic
over an extended period of time. In this instance, stability refers to the predictability of the equipment over
time.

The appropriate time interval is often a major consideration when analyzing the measurement system.
Knowledge of the circumstances and conditions in which the equipment is used will help identify special
causes when the system is unstable. Action should be taken to make the measurement system robust to the
conditions that cause instability.

The more likely it is that the system will change; the shorter the time interval should be between samples.
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See Also

Measurement systems terminology

Accuracy and precision

Bias

Linearity

Part-to-part variation

Probable error

Repeatability (equipment variation)

Reproducibility (operator variation)

Uncertainty

Remember

Accuracy and precision

Accuracy and precision

Accuracy is the difference between the observed average of measurements and the "true" average. The
"true" value can be determined by taking a master measurement using "master" gages or equipment.

Accuracy = True Measurement - Observed Average

Precision reflects the ability of the operator or equipment to repeat or duplicate readings. This is sometimes
referred to as reproducibility.

See Also
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Repeatability (equipment variation)
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Reproducibility (operator variation)

Uncertainty

Remember

Bias

Bias

Bias is a measure of how accurate a measurement system is on the average. If the mean of the
measurements equals the true value, then the measurement system has zero bias. Generally one is
interested in both how close to the true value the measurement is on the average, and in how dispersed the
values are around the true value. These concepts are often referred to as Accuracy and Precision. Accuracy
and Bias are very similar in concept as are Uncertainty and Precision. Uncertainty and Bias are often
determined using the same study if a true value can be obtained for the part measured or if a known
standard is used for taking the measurements. See Uncertainty.

See Also
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Linearity

Linearity

Linearity is similar to Bias except that it goes throughout the operating range of the gage. The assumption is
that the bias can vary based on the size of the measurement of the gage. In this case, an appraiser takes
parts or standards with known values throughout the operating range of the gage and measures each of
them several times. Least squares regression is used to fit a line to the data.

See Also
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Reproducibility (operator variation)

Uncertainty

Remember

Part-to-part variation

Part-to-part variation

This is the variation that exists among parts included in the analysis. The part values are determined by
averaging all the measurements made by the appraisers for a part. The range for the parts is determined by
subtracting the smallest part average from the largest part average. This value is then used to estimate the
standard deviation for the part production process (referred to as Study Parameters in GAGEpack).

See Also
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R&R stability study
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Probable error

Repeatability (equipment variation)

Reproducibility (operator variation)

Uncertainty

Remember

Probable error

Probable error

Probable error is used to help define the effective resolution of a measurement. It describes the average
deviation between a measurement and the average of multiple measurements of the same item. This
deviation can be compared to the unit of measure to assess the "effective" resolution of the measurement
system.

See Also
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Remember

Repeatability (equipment variation)

Repeatability (equipment variation)

Repeatability is the variation in the repeated measurement of a single characteristic for one part, by one
operator. Frequently, a study will have several parts, several operators, and more than one gage.
Repeatability answers the question of how much variation there is among these repeated measurements.
This is also called Test-Retest Error or Equipment Variation.

See Also
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Reproducibility (operator variation)
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Reproducibility (operator variation)

Reproducibility (operator variation)

Reproducibility is the comparison of the average of all measurements made by each operator to the grand
average across all parts and operators when measuring the same characteristic over the same parts. This is
a measurement of how much each operator affects the average of the measurement (measuring too high or
too low on a consistent basis—called bias). If these measurement averages are different across operators, a
bias exists in the measurements.

See Also
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Uncertainty

Uncertainty

Measurement uncertainty is a term used to describe the quality of a measured value. It is the range assigned
to a measurement result that is expected to contain the true measurement with some level of confidence -
usually 95 percent. Generally one is interested in both how close to the true value the measurement is on the
average, and in how dispersed the values are around the true value. These concepts are often referred to as
Accuracy and Precision. Accuracy and Bias are very similar in concept as are Uncertainty and Precision.
Uncertainty and Bias are often determined using the same study if a true value can be obtained for the part
measured or if a known standard is used for taking the measurements.

To find the uncertainty for a particular part measurement, one takes one appraiser, one gage, and one part
and has the appraiser measure the part several times (typically 10 to 100). The standard deviation is
estimated using the range or the least squares method and a plus/minus factor is determined using either
the t-distribution or the normal distribution with a level of confidence (e.g., 95%). At this point the analogy is
flip-flopped from the interval containing 95% of the sample values to a 95% chance that the interval contains
the true value. This is not a bad analysis except for Bias. If there is a Bias in the measurement, it can be
large enough to exclude the true value from being with in the interval completely, or at a minimum, change
the confidence level percentage. See Bias.

See Also

Measurement systems terminology
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Repeatability (equipment variation)
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Remember

Remember

Primary principles of measurement apply to the process of quantification and the resulting number when
using such a process. Prior to performing a measurement, it is important to have the proper measuring
device that has been calibrated to a known, traceable source. The device must also be able to detect the
variation of the characteristic being measured. Therefore, the discrimination unit must be small enough to
identify the variation within the units being measured.

See Also

Measurement systems terminology

R&R stability study

Accuracy and precision
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Part-to-part variation

Probable error

Repeatability (equipment variation)

Reproducibility (operator variation)

Uncertainty

What is MSA?

What is MSA?

Measurement systems analysis (MSA) is the study of the sources of variation within the measurement
system. Variation due to the measurement system is one of many sources of variation within the overall
system. The MSA provides knowledge about how much variation can be attributed to the measurement
system.

Measurement systems analysis provides the system operator an opportunity to understand how variation
affects the data. Any organization that bases decisions on generated numbers needs to perform an analysis
of the measurement system. These organizations live by the credo, "If you canʼt control the numbers
generated, you canʼt control the process that generated the numbers." The outputs of any system are only
as good as the inputs. MSA can provide some confidence in the measurement system.

Conducting MSA is a requirement for ISO 9000 certification and compliance with many other standards. MSA
must be included with any quality system to help the users of the system achieve compliance.

Scrutiny of the system helps to reduce the amount of bias that may occur in the system. It is human nature
to accept data when:

§ The data has been generated in a logical manner;
§ The data has been generated using approved procedures;
§ The data has been generated by someone with "more experience"
§ The numbers look "right."

Failure to recognize variation in measurement data may result in:

§ inaccurate decisions;
§ misdirected capital expenditures;
§ costly retraining of employees;
§ customer dissatisfaction;
§ or other negative conditions.

In This Section

When is MSA done?

How do you do MSA?

Remember

See Also
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What is a measurement system?
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When is MSA done?

Conduct measurement system analysis for any of the following:

§ To assess the measurement system to determine the factors that influence the variation;
§ To help to understand the variation which is produced by the different areas within the process;
§ To better understand the process;
§ To establish confidence in the measurements coming from the measurement system;
§ To compare measuring equipment before and after repair or calibration;
§ To evaluate measuring equipment suspected of being faulty;
§ To determine acceptance of a new measurement system (new process/products).

See Also

What is MSA?

How do you do MSA?

Remember

How do you do MSA?

How do you do MSA?

1. Determine the objective.
o Before starting the study, the desired objective should be determined. Typical objectives are

listed:
§ New quality equipment.
§ Compare measuring devices.
§ Evaluate suspect gage.
§ Evaluate continued use of a gage after a process implementation has been made.
§ Compare gage performance prior to calibration with post calibration.
§ Assess whether a factor influences the variation of a measurement system.
§ Assess how much a factor contributes to the variation of a measurement system.
§ Establish confidence in the measurement system.

2. Select characteristic (dimension) of interest.
o Determine the units and the characteristic to be measured, such as length, inside diameter,

hole to hole, viscosity, density, etc.

3. Select factors to be studied.
o Select the factors that appear to influence the measurement variation and the number of levels

of each factor. Generally, only one or two factors are considered for a single study. Typical
factors are operators, measurement method, gages, shifts, etc.

4. Determine the number of parts.
o Determine the number of parts to be used in the study. If process data is not known (data is

not available from a process control chart on the process), the parts should be selected to
represent the total spread of the process. Generally, a study consists of five to ten parts. 

5. Determine the number of replications.
o Determine the number of replications (re-measurements for a part) to be used in the study.

Generally, a study consists of 3 to 5 replications.
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1. Gather data.
o During the data collection phase, the items listed below must be observed.

a. Assure that the measuring method is applied to the desired characteristic and that the defined
gaging procedure(s) is being followed.

b. In reading the gage, the reading should be made to the smallest graduation on the gage or to
one-half the smallest graduation.

c. The measurements should be made in a random order to ensure any drift or changes are
randomly spread throughout the study. The operator measuring the parts should be unaware
of the identity of the part to avoid any possible bias. NOTE: this requires the part be identified
by the person conducting the study.

1. Analyze results.
o Analyze results following the method selected for analysis.

2. Take appropriate action.
o  Evaluate options for action. Plan and carry out options such as training operators, repairing

instruments, calibrating instruments, replacing instruments, or standardizing procedures.

See Also

What is MSA?

When is MSA done?

Remember

Remember

Remember

Product and process conformance are determined by measurements made by the measurement system. Any
error in these measurements has a direct bearing on conformance as defined within the system. A clear
understanding of the results of the measurement system requires an understanding of the possible error
within the system.

MSA is a process for determining the sources and effects of variation within the measurement system. Any
organization that generates numbers and bases decisions on numbers must assess its measurement system.
Those customers of the measurement system must have confidence in the results of the system. MSA
provides this confidence by creating a better understanding of the process and identifying the factors
contributing to the measurement variation.

See Also
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How do you do MSA?
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